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User Manual
Read Me First
Thank you for purchasing your new MV-8XX multiviewer product which contains the Grass 
Valley MV-8 Series Multiviewer core. 

When using your MV-8XX multiviewer you will need access to the following Grass Valley 
documents, available from the Grass Valley website:

1 This manual - MV-8 Series Core Multiviewer User Manual - for information on the core 
multiviewer features, control screens, ‘getting going’ instructions, and maintenance.

2 The specific MV-8XX user manual for your product. 
(E.g. for MV-821 devices, use the MV-821 Multiviewer User Manual.)

About this Manual
This user manual describes how to configure and operate the core MV-8 Series Core 
Multiviewer within your MV-8XX Multiviewer product. If you have any questions regarding 
the installation and setup of your product, please contact Grass Valley Customer Support.

Related Documents

MV-8 
Multiviewer 

Core

Video

Video wall(s)

Related Document Describes:

MV-8 Series Core Multiviewer 
User Manual (This document)

Core multiviewer engine within MV-8xx products.

MV-801 Multiviewer User Manual Physical & specific details of MV-801 multiviewer product.

MV-821 Multiviewer User Manual
Physical & specific details of MV-821-HDBNC and MV-821-IP multiviewer 
products, including video IP rears.

MV-831 Multiviewer User Manual Physical & specific details of MV-831 integrated multiviewer product.

MV-841/851 Multiviewer 
User Manual

Physical & specific details of MV-841/851integrated multiviewer products.

MV-825-RTR Multiviewer 
User Manual

Physical & specific details of MV-825-RTR multiviewer with integrated video 
router.
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Document History

Publication 
Date Document Number

Issue and 
Revision Notes

2019-Mar-14 RMY3 MV8-UM Iss-1 Rev-1 Original document. 
Description of the common core multiviewer v3.0 
for MV-8X0 Multiviewers. 
Includes information on: HDR support, Media 
Biometrics, XDS support, Embedded audio on 
head display outputs, SNMP support.

2019-Jul-23 RMY3 MV8-UM Iss-1 Rev-2 Covers emerging MV-8X1 multiviewer products 
and H.264 license option; and includes the MV-
800-DT Orbit option and RTSP streams.

2020-Apr-14 RMY3 MV8-UM Iss-1 Rev-3 Covers core MV-8 multiviewer s/w v3.2, includes: 
Input-Copy H.264 streams; HDR on support 
outputs. MV-821.

2020-Jul-29 RMY3 MV8-UM Iss-2 Rev-1 Core MV-8 multiviewer s/w version v3.3, includes 
NTP timestamp in Media Biometrics signature. 
Document also includes: Input Audio chapter; and 
sub-sections on: Audio Meters, Input Audio 
Loudness and Phase. GV Orbit now replaces Orbit 
in the document and MV-800-DT information is 
removed.

19 November 
2020

RMY3 MV8-UM Iss-2 Rev-2 New products MV-801 and MV-825-RTR added. 
MV-8XX supported RollCall commands added.
H.264 input-copy latency information added.
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Core Multiviewer Overview
The MV-8 Series Core Multiviewer is the core multiviewer “engine” within the Grass Valley 
MV-8x0/8x1/825 Multiviewer product range. Various video input and video wall output 
signal types are supported by the product range. 

This user manual describes the MV-8x0/8x1/8x5 Multiviewer product range’s common core 
multiviewer features and includes the features of the MV-8 Series Multiviewer software. (For 
descriptions of each specific MV-8x0/8x1/8x5 Multiviewer product, please refer to its 
corresponding product user manual.)

Fig. 1-1: MV-8 Series Multiviewer

MV-8 Series 
Multiviewer
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Core Multiviewer Overview
Features of MV-8 Series Multiviewer
An MV-8 Series Multiviewer core “engine” can provide up to 12 multiviewer head display 
outputs, displaying video tiles from 48 video inputs. Video wall layouts from multi-channel 
quad-splits to flexible multi-tile screens are available.

Features of MV-8 Series Multiviewer
A core MV-8 Series Multiviewer is found in MV-8x0/8x1/8x5 Multiviewer products and for all 
product-specific information, please refer to the respective product user manual (for 
example, MV-821 User Manual).

Video Inputs: 
• 48 multiviewer video inputs.
• HDR support per input and output.
• Media biometrics support per input.

Up to 12 head display outputs: 
• 3G 1080p or HD 720p head display outputs with embedded audio.
• 4K UHD support with four head display outputs used together as quad-link.
• Four head display outputs on a baseline MV-8 Series Multiviewer model. 

More head display outputs enabled with licenses.
• Video walls designed with the GV Orbit Client software tool.

Screen layout flexibility:
• Additionally display web pages, automation play lists, device status screens etc.
• Display status and alarms from external devices.
• Drag and Drop objects onto the screen layout and tailor custom on-screen 

functionality.
• Adjustable layering, transparencies and fine-positioning.

Flexible alarm capability:
• Monitoring of video, audio and metadata, with alarm notifications.
• Intelligent monitoring of external devices, with configurable on-screen alarms.
• Control and acknowledgment of alarms from hardware- and soft-panels.

H.264 Streaming out of MV-8 Series Multiviewer ‘Input-copies’:
• Extend and expand monitoring with this licensed option. 
• MV-8 Series Core Multiviewer inputs may be scaled and compressed to create H.264-

encoded copies which can then be streamed out over an IP connection. 
Note: An MV-8X1 unit requires a ‘H.264 stream’ license.

• Viewable on a desktop PC with Grass Valley’s GV Orbit software or older Orbit Client 
software. 
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New in MV-8 Series Multiviewer Software

V3.3
New features in software v3.3 include:

• NTP timestamp in bio-metric signatures. (See Media Biometrics Support, on page 79.)

Earlier Versions
Features in software v3.2 include:

• Input-copy - scaled/compressed H.264 streams for monitoring
(See Core MV Input-Copy H.264 Streams, on page 71.)

• High dynamic range (HDR) input/output support.
(See HDR Support, on page 75.)

Features in software v3.0 include:
• High dynamic range (HDR) input support.

(See HDR Support, on page 75.)
• Media Biometrics Generators on a per input basis. 

(See Media Biometrics Support, on page 79.)
• CC.608 extended data services (XDS) support. 

(See Extended Data Services Support, on page 81.)
• User-defined names for multiviewer video walls/layouts. 

(See Layout Control Screen, on page 31.)
• Embedded audio on multiviewer head display outputs.

(See Output Embedded Audio Support, on page 87.)
• SNMP Community Strings user-definable. 

(See SNMP Community Strings box, on page 24.)
3
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Order Codes
Order Codes

Software Compatibility

 Table 1-1:   Order Codes MV-8 Series Multiviewer

Order Code Description

Products: For specific MV-8xx product order codes/licenses, refer to the 
corresponding multiviewer user manual.

Licenses: A license comprises a code to enable more functionality.

 Head outputs: Enables more multiviewer head display outputs (output 5 
onwards).

Note: SFPs for extra head display outputs must be ordered 
separately.

MV-8XX-OP56 ‡ License to enable outputs 5 and 6.

MV-8XX-OP78 ‡ License to enable outputs 7 and 8. 

MV-8XX-OP910 ‡ License to enable outputs 9 and 10. 

MV-8XX-OP112 ‡ License to enable outputs 11 and 12.

 Input-Copies:

MV-8X1-H264 Enables H.264 streaming out of scaled, H.264-encoded 
multiviewer input-copies. (‘H.264 Stream’ license.)

Note: This is a factory-installed option on MV-821.

‡ See the corresponding MV-8x0/8x1/8x5 Multiviewer product user manual for the 
respective output license name.

 Table 1-2:   Software Compatibility  

Software Version

MV-8 Series Multiviewer 3.3 or later

RollCall Control Panel 4.19.0 or later

Orbit Client

GV Orbit Client

3.1.15 or later

4.0.0 or later
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a) M

c) M
MV-8 Series Multiviewer Architecture
The MV-8 Series Multiviewer is found in the MV-8x0/8x1/8x5 Multiviewer  range, which 
covers a multiplicity of products, including multiviewers that are integrated into routers, in 
standalone boxes, and/or have video IP input capabilities. Figure 1-2 and Figure 1-3 identify 
the MV-8 Series Multiviewer “engines” found in some MV-8x0/8x1/8x5 Multiviewer 
functional block diagrams. And Figure 1-4 gives a core multiviewer block diagram.

Fig. 1-2: Examples of MV-8 Series Core Multiviewers in MV-8xx Multiviewer Products:

V-801

V-831 d) MV-841/MV-851

MV-8 Series Core Multiviewer shown in MV-8x0/8x1/8x5 Multiviewer product functional 
block diagrams

b) MV-821-IP
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MV-8 Series Multiviewer Architecture
Fig. 1-3: MV-8 Series Core Multiviewer in MV-825-RTR Multiviewer Product

Fig. 1-4: Block Diagram of MV-8 Series Core Multiviewer

MV-8 Series Core Multiviewer shown in product functional block diagrams
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Figure 1-4 shows a simplified block diagram of the MV-8 Series Core Multiviewer. The main 
inputs and outputs of the MV-8 Series Multiviewer come from or go to the MV-8xx product 
and comprise: 

• 48 Video Inputs.
• Video Reference Timing.
• Up to 12 Multiviewer Head Display Outputs.
• Control and Monitoring.

Each video input is processed and then re-sized. There is one re-sizer (scaler) per input. 

Each multiviewer head display image is composited from re-sized video images, rendered 
graphical images and text.

Note: Each one of the 48 re-sized (scaled) inputs may appear any number of 
times on any head display output but with the same re-sizing.
7
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Input Processing
Input Processing
Each video input undergoes the same processing. Processing includes:

• Status.
• HDR input support.
• Media biometrics.

Additionally, a copy of each video input can be sent to an H.264 scaler/encoder on the MV-
8xx product and H.264-encoded, scaled-down copies of the video inputs are available as 
video streams. 

HDR Input Support 
The MV-8 Series Multiviewer supports HDR video inputs. Each multiviewer input has a 
selectable video dynamic range converter (HDR to SDR) which can handle different opto-
electrical transfer functions (OETFs) and color space for HDR video inputs. 

(See HDR Support, on page 75.)

Media Biometrics on Inputs
The MV-8 Series Multiviewer supports media biometrics on video inputs for media 
assurance. Each multiviewer input has a media biometrics generator which generates 
signatures for the input video and for the input audio. The media biometrics generators are 
fully compatible with Grass Valley’s Media Assurance SigMA platform.

(See Media Biometrics Support, on page 79.)

Control and Monitoring
The control and monitoring interface is connected to one or more Ethernet network 
interfaces on the MV-8xx product. It is used for:

• control and monitoring; 
• software upgrades and licensing;
• all RollCall messaging; and 
• pushing/pulling video wall designs (GV Orbit multiviewer projects).

Note: An MV-8x1/8x5 requires a corresponding ‘H.264 stream’ license. 
For example, ‘MV-821-H264’ for MV-821.

Note: Licensing for MV-821 products specifically involves factory-fitted 
H.264 encoder modules.
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MV-8 Series Core Multiviewer Set up 

Getting Started
Hardware installation is described in the user manual for the respective MV-8xx product. 
For initial getting started instructions, see Core MV Getting Started, on page 119 which 
includes the basic configuration of the MV-8 Series Multiviewers unit.

Configuring alarms and audio for the core multiviewer is done via GV Orbit Client. See 
Getting Started with GV Orbit, on page 131, for configuration instructions and a quick 
introduction to editing a video wall.

Video Wall Design with GV Orbit
The layout and style of video walls are designed with the GV Orbit Client software 
application: Wall designs are stored as individual projects (GV Orbit multiviewer projects), 
which are then pushed to an MV-8xx unit, for use by the MV-8 Series Core Multiviewer 
‘engine’ inside. 

Multiple wall layout designs may be generated and stored on a PC. Different wall designs 
can then be pushed to the multiviewer unit for various multiviewer applications.

Terminology
See Multiviewer Terminology, on page 195 for some multiviewer terminology and its 
meaning.
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Core MV Control Screens
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Introduction
Introduction
This section describes the control screens (RollCall templates) of an MV-8 Series Core 
Multiviewer and is common to MV-8X0/8X1/8X5 Multiviewer products. 

Following initial configuration of the multiviewer, the control screen may then be used to 
configure and control various operational multiviewer items, including: selection of video 
wall layouts; monitoring alarm status; acknowledging alarms; and control of timer widgets 
on the video wall.

The control screens can be viewed with GV Orbit Client, or RollCall Control Panel.

Note:
For multiviewer products which contain a core multiviewer plus one or 
more other functional block(s) which may require configuration, please 
also refer to the respective multiviewer user manual.
For example: 
The MV-821 has an IP variant, MV-821-IP, and this contains four video IP rears 
which are configured separately. Please refer to the MV-821 Multiviewer user 
manual for video IP rear configuration.
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Control Screen Banner
Several MV-8 Series Multiviewer control screens are available. The upper, ‘banner’ section of 
each control screen is the same, see Figure 2-1.

Fig. 2-1: Control Screen Upper ‘Banner’ Section (MV-821 shown)

Control Screen Selection
MV-8 Series Multiviewer control screens may be selected from the Selection box in any 
control screen:

A control screen may be accessed quickly from any of the control screens by right-clicking 
anywhere in a control screen and then selecting a control screen name in the full list that 
appears.

Selection box System box NTP Status box

Banner 
section

System - Setup: See System-Setup Control Screen on page 16

Video Alarms:  See Video Alarms Control Screen on page 25

Audio Alarms:  See Audio Alarms Control Screen on page 26

Reference Alarms: See Reference Alarms Control Screen on page 28

Ancillary Alarms: See Ancillary Alarms Control Screen on page 29

Layout:  See Layout Control Screen on page 31

TSL:  See TSL Control Screen on page 35

GPIO: See GPIO Control Screen on page 36

LTC: See LTC Control Screen on page 37

Timer Control: See Timer Control Screen on page 39

Timer Request Protocol: See Timer Request Protocol Control Screen on page 41

Media Biometrics: See Biometrics Setup Control Screen on page 42

HDR Setup: See HDR Setup Control Screen on page 44

Audio Codec Selection: See Audio Codec Select Control Screen on page 47
13
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System Box
Fig. 2-2: Full List of MV-8 Series Multiviewer Control Screens

System Box
A control screen’s System box (see Figure 2-1) displays the multiviewer system status at the 
top of each control screen: 

• OK - the multiviewer is working correctly. 
• Fail - the multiviewer has a problem. 
• Restart Required - the MV-8 Series Core Multiviewer requires a restart. (This is 

indicated for some configuration changes which require a restart before the change 
takes effect.) 

NTP Status Box
A control screen’s NTP Status box (see Figure 2-1) displays the status of the multiviewer’s 
network time (network time protocol, NTP) at the top of each control screen.

Right-click on a control screen to see this list;
then click on a control screen name to access the control 
screen.
14
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Settings Changes and System Reset
Settings changes can be done at any time. But settings changes done in the System-Setup 
control screen will need a ‘System Reset’.

Settings changes outside of the System-Setup control screen do not require a system reset 
to be carried out. These settings include:

• Video alarms - See Video Alarms Control Screen on page 25
• Audio alarms - See Audio Alarms Control Screen on page 26
• Reference alarms - See Ancillary Alarms Control Screen on page 29
• Ancillary data alarms - See Ancillary Alarms Control Screen on page 29
• Layout settings - See Layout Control Screen on page 31
• TSL settings - See TSL Control Screen on page 35
• GPIO settings - See GPIO Control Screen on page 36
• LTC settings - See LTC Control Screen on page 37
• Video wall timer control - See Timer Control Screen on page 39
• Timer Request Protocol - See Timer Request Protocol Control Screen on page 41
• Media Biometrics - See Biometrics Setup Control Screen on page 42

CAUTION 
Some System-Setup control screen changes may affect the MV-8X0/8X1/
8X5 Multiviewer unit’s network operation.

IMPORTANT 
A System Reset of the multiviewer is required after settings changes are 
made in the RollCall System-Setup control screen.

Such a reset will affect all MV-8X0/8X1/8X5 Multiviewer product’s 
connections, including the multiviewer outputs. See “System Reset” box, 
on page 18.

When the MV-8 Series Multiviewer has re-booted, the new settings will be 
adopted.
15



Core MV Control Screens
System-Setup Control Screen
System-Setup Control Screen 

The System-Setup control screen (see Figure 2-3) comprises various information boxes 
which display basic information about the multiviewer, for example, system status, product 
name and software version. It is also used to setup the following system details:

• Networking.
• NTP servers.
• Router controller addresses.
• RollCall settings.
• Multiviewer monitor output format.
• Multiviewer name. 
• Multiviewer Input H.264 streaming out.
• SNMP settings.

Note: The multiviewer must be System Reset for any saved setting changes 
to take effect, “System Reset” box, on page 18.
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Fig. 2-3: Multiviewer System-Setup Control Screen (MV-800 shown)
17



Core MV Control Screens
“System Reset” box
“System Reset” box
This box contains a System Reset button which resets (reboots) the MV-8 Series 
Multiviewer Multiviewer. This is used to make any System-Setup control screen 
configuration setting changes take effect. Performing a system reset makes the multiviewer 
use the new settings. 

A system reset reboots the multiviewer by effectively powering it down and then powering 
it back up: This will interrupt and produce a picture disturbance on all MV-8 Series 
Multiviewer multiviewer outputs.

Fig. 2-4: System-Setup Control Screen Boxes

Product box
see “Product” box, 
on page 19

System Reset box
see “System Reset” box, on page 18

Network Settings box see “Network Settings” box, on page 19

NTP Servers box see “NTP Servers” box, on page 20

Router Controller Settings 
see “Router Controller Settings” box, on page 20

Streamed Output box
see “Streamed Output” box, on 
page 22

Output Format box
see “Output Format” box, on 
page 21

Reference Input box
see “Reference Input” box, on 
page 22

Information box
see “Information” box, on page 23

RollCall Settings box
see “RollCall Settings” box, on page 21

SNMP Managers box
see SNMP Managers box, on page 24

SNMP Community Strings box
see SNMP Community Strings box, on page 24

SNMP panes

IMPORTANT A system reset of the multiviewer will affect all outputs. 
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Once all changes in the System-Setup control screen have been done, carry out a system 
reset: 

1 Click on the System Reset button.
2 Then click on the Confirm button to perform a system reset. 

Or click the Cancel button to abort the system reset.

See Booting and Splash Screen, on page 9, for more information on module booting.

“Product” box
Displays multiviewer details:

• Product - The name of the MV-8X0/8X1/8X5 Multiviewer product containing the MV-8 
Series Multiviewer. 

• Serial Number - The serial number of the product. 
• Software Version - The currently installed software version number. 
• Build Number - The currently installed software build number. 
• FPGA Version - The currently installed FPGA firmware version number. 

“Network Settings” box
The Network Settings area of the System - Setup control screen shows the MAC addresses 
and any network interface bonding status of each of the MV-8 Series Multiviewer IP 
network interfaces and is used to set the network details for each of the MV-8 Series 
Multiviewer IP interfaces. 

Network interfaces covered:
• 2-off 1G Ethernet interfaces (“1G1”, “1G2”). 

 (MV-8 Series Multiviewer default IP addresses are given the respective MV-8X0/8X1/
8X5 Multiviewer product user manual.)

• 1-off “Eng” Interface”, default IP address 10.54.31.224.
 (Reserved for Grass Valley engineering use.)

Enter all the network interface details in the text boxes: 
• IP Address - Set the interface IP Address. 
• Subnet Mask - Set the interface Subnet Mask. 

Note: “S” and “P” buttons - 
After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally 
save the new setting. Do this for each text box. 
(Note: Clicking on the “P” button will return the setting to its preset 
default value).

“S” - Locally save new setting value (or press “return”).

“P” - Locally save default setting value.
19
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• Default Gateway Address - Set the interface Gateway address. 
• MAC address - Displays the IP interface MAC address. 
• DHCP - Enabled check box:

• Select to automatically set the IP address details from the network DHCP server.
• Leave box deselected to use the entered IP address settings.

• DNS Server - Set the primary and secondary DNS server IP addresses.

“NTP Servers” box
Up to four NTP (Network Time Protocol) server URLs or IP addresses can be configured. 
The NTP servers are used to synchronize clocks displayed on multiviewer video walls with 
the specified NTP server.

• NTP Server Address - Enter the NTP server address in the text box and click on the S 
button to save the new setting. Do this for each address entered.

“Router Controller Settings” box 
A Grass Valley router frame may provide input video to a multiviewer; the router will have a 
main router controller and possibly a backup controller. The IP address and IP port details of 
both router controllers are set up in this box: Port details must correspond to port settings 
in the router configuration. 

This allows a multiviewer to display source tallies for the video inputs being displayed by 
the multiviewer and also to control router crosspoints when necessary.

For the main router controller and for the backup controller, enter
• IP Address - Set the router controller IP address. 
• IP Port - Use the default controller IP port number, unless the port has been changed 

on the router controller. 
Click on the P button to return the setting to its default value, if required.

Note: The IP address details are only used when the corresponding “DHCP 
Enabled” box is deselected. 

Note: At the next System Reset, the MV-8 Series Multiviewer will adopt all 
the locally saved settings. 

Note: “S” and “P” buttons - After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally save 
the new setting. Do this for each text box. (Note: Clicking on the “P” 
button will return the setting to its preset default value).

Note: “S” and “P” buttons - After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally save 
the new setting. Do this for each text box. (Note: Clicking on the “P” 
button will return the setting to its preset default value).
20
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Enter the source name length (number of characters): 
• 4, 8, 12, 16 or 32.

“RollCall Settings” box
The RollCall settings are used to allow GV Orbit Client software applications to control the 
MV-8 Series Core Multiviewer and should normally be changed if you have multiple MV-8 
Series Multiviewer units on the same RollCall network.

 

• RollCall Network - Displays the RollCall address, which may not be changed. 
It is not an IP network address.

• RollCall Unit - Set the RollCall unit number. The unit number must be unique for each 
Multiviewer being configured. The initial default value is “01”.

• RollCall Port - Displays the RollCall port number. 
• RollCall IP Port - IP port number used by RollCall messages. This can usually be left to 

its displayed value. 
• Domain ID - RollCall+ uses the concept of domains to partition a RollCall network. Only 

those RollCall-enabled devices on the same RollCall+ Domain can communicate with 
one another. A domain is uniquely identified with a Domain ID number. Domain ID is 
also used by GV Orbit software when connecting to an MV-8 Series Core Multiviewer.

• The Domain ID can typically be left at its default value, 100. 
(This default value is reserved for multiviewer RollCall traffic.) 

• To reset the Domain ID to the default value of 100 click on the P button. 
• To set the Domain ID, enter the Domain ID number in the text box and click the S 

button to locally save the new setting.
• Ethernet Interface - Set which multiviewer IP interface to use for RollCall messages. 

The selected interface must be connected to the network.

“Output Format” box
MV-8 Series Multiviewer multiviewer head display outputs can be 1080p or 720p.

The Output Format setting sets the format and frame rate for all of the multiviewer head 
display outputs. All outputs share the same format and timing.

Note: “S” and “P” buttons - After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally save 
the new setting. Do this for each text box. (Note: Clicking on the “P” 
button will return the setting to its preset default value).

Note: A RollCall address has the form: NNNN:UU:PP 

where:
 NNNN is the RollCall network number.
 UU is the RollCall unit number.
 PP is the multiviewer input number (01, 02 etc).
21



Core MV Control Screens
“Reference Input” box
“Reference Input” box 
Set which router/unit reference input is used by the MV-8 Series Multiviewer to synchronize 
its head display outputs to. Select reference source from the drop down list. Settings 
choices are:

• Reference IP 1. (Rear panel analog reference input 1.)
• Reference IP 2. (Rear panel analog reference input 2.)
• Reference IP 3. (Rear panel analog reference input 3, on router-integrated 

multiviewers.)
• Reference IP 4. (Rear panel analog reference input 4, on router-integrated 

multiviewers.)
• Free Run.

Note: On the MV-820/821-IP products, there is only one rear analog reference input.

“Streamed Output” box
The Streamed Output settings box contains details about the ‘H.264 streaming’ out of 
multiviewer video input-copies. (This is a licensable codec option on MV-8X1 multiviewer 
units - ‘H.264 stream’ license option - and with factory-fitted hardware being required for 
the MV-821.) 

Multiviewer video inputs are scaled-down (to standard definition size) and streamed out as 
multicast H.264-compressed copies of each input, one RTSP stream per multiviewer video 
input.

• Ethernet Interface - Select Ethernet interface, port 1 (1G1) or port 2 (1G2). 
This setting must be the same as the RollCall Ethernet Interface setting in the RollCall 
box of the System-Setup control screen.

• IP Port - Typically, use the default value.
• Multicast Group Base Address - The base IP address for multicast Streamed Output. 

Enter an IPv4 IP address in the range: 232.0.0.0 to 232.255.255.207. 
Click “S” to save a new setting.

If left blank, then a multicast base address will be chosen randomly from the range 
232.0.0.0 to 232.255.255.207.

(See Multicast Group Addresses, on page 23 for more details about the base address 

Note: When changing output format, a GV Orbit multiviewer project change 
is required. 

Note: When driving a 4K monitor, each MV-8 Series Multiviewer multiviewer 
head display output drives one quadrant of the 4K monitor. 

Some 4K monitors have four 1080p inputs, so they can be fed 
from four MV-8 Series Multiviewer 1080p outputs. If this is not the 
case, a separate adapter must be used to convert four MV-8 Series 
Multiviewer multiviewer head display outputs to a single 4K signal 
suitable for the monitor. 
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and multicast addresses used.)
• Enable - Check box. Select to enable streaming out of the H.264 input-copies.

Multicast Group Addresses
The multicast group addresses used for Streamed Output will be sequential, starting at the 
set base address. There is one H.264-encoded input-copy stream per multiviewer video 
input. 
For example:
 input 1 stream uses 232.0.0.0; 
 input 2 stream uses 232.0.0.1; 
 input 3 stream uses 232.0.0.2; and so on up to
 input 48 stream uses 232.0.0.47 .

A Multicast Group Base Address configured on the System-Setup control screen must be 
within the allowed IPv4 range (232.0.0.0 to 232.255.255.207).

If the Multicast Group Base Address field on the System-Setup control screen is left 
blank, then a base address is automatically randomly chosen from the IP address allowed 
range 232.0.0.0 to 232.255.255.207 . 

Define a Multicast Group Base Address for:
• An installation which requires particular multicast IP addresses to be used.
• Installations with more than one MV-8 Series Multiviewer device on the network.

“Information” box
This box contains text fields which can be set up by the user, enabling the user to enter 
name, location and notes about their multiviewer unit.

To enter/modify text in the text box, type directly into the editable text field and click the S 
button. To return to the default text, click the P button.

Note: A Multicast Group Base Address in the range 
232.0.0.0 to 232.255.255.207 will use the ‘Source-Specific 
Multicast’ assigned local host address block, 232/8, for the 
multicast addresses.

Note: If there is more than one MV-8XX device is on the network, then 
it is recommended that specific Multicast Base Addresses are 
set up in the control screen of each MV-8XX device.

Explanation: 
If Multicast Group Base Address is left blank, then it is 
automatically randomly chosen. In this case, there is a small 
chance that different multiviewers may use some or all of the 
same multicast addresses for H.264 streamed outputs.
23



Core MV Control Screens
SNMP Managers box
• Name - A meaningful name may be given to the multiviewer unit, making it easier to 
identify. 
 Maximum 32 characters. 
 Remember to press S or press return to save the name locally.

• Location - Multiviewer location details may be entered, to make it easier for the user to 
locate the multiviewer. 
 Maximum 64 characters. 
 Remember to press S or press return to save the name locally.

• Notes - Extra user information about the multiviewer may be entered. 
 Up to 64 characters can be displayed in the notes field.
 Remember to press S or press return to save the name locally.

SNMP Managers box
This box contains IP addresses of all SNMP manager devices. 
Enter each IP address.

SNMP Community Strings box
This box lists the SNMP community strings for SNMP Get, Set and Trap message types. 
Enter the strings for each SNMP message type

System Reset to Implement Settings Changes
After all System-Setup control screen settings changes have been made, an MV-8 Series 
Multiviewer System Reset is required. See “System Reset” box, on page 18.

Note: “S” and “P” buttons - After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally save 
the new setting. Do this for each text box. (Note: Clicking on the “P” 
button will return the setting to its preset default value).
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Video Alarms Control Screen
The Video Alarms control screen allows the user to:

• See the state of alarms related to the video picture for each MV-8 Series Multiviewer 
input 

• Acknowledge alarms. 

The MV-8 Series Multiviewer input video number is selected by the Video Input Selection 
drop-down menu box. See Figure 2-5.
 

To acknowledge an alarm, select the corresponding Alarm Ack check box on the right-
hand side of the control screen.

Note: Alarms can be viewed and acknowledged on this control screen.

Multiviewer alarms are set up with the GV Orbit Client software 
application.

Fig. 2-5:  Video Alarms Control Screen

 Table 2-1:   Video Alarms

Alarm Description

Blackish Detection Active when the video picture is detected to be black 
or nearly black.

Stillish Detection Active when the video picture is detected to have no 
motion present.

Freeze Detection Active when the video picture is frozen.

Input Signal Detection Active when no input signal is detected.

Input Format Change Detected Active when a change of video format is detected at 
an input. For example, from 1080p to 720p.

Video Input Selection
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Audio Alarms Control Screen
The Audio Alarms control screen allows the user to:

• See the state of alarms related to embedded audio channels accompanying the video 
picture for each multiviewer input. 

• Acknowledge alarms.

Figure 2-6 on page 27 shows the Audio Alarms control screen. 

The video input number is selected by the Video Input Selection drop-down menu box. 

There are 32 audio channels per video input, i.e. 16 stereo pairs. 
Audio channels, or channel pairs, are selected with the Audio Channel Selection pull-
down box, in groups of eight (i.e. channels “1 to 8”, “9 to 16”, “17 to 24” and “25 to 32”). 

To acknowledge an alarm, select the corresponding Alarm Ack check box on the right-
hand side of the control screen.

Audio alarms may operate on a per audio channel or channel-pair basis.

Note: Alarms can be viewed and acknowledged on this control screen.

Multiviewer alarms are set up with the GV Orbit Client software 
application.

 Table 2-2:   Audio Alarms

Alarm Channel or 
Channel-pair Description

Audio Level per channel The following audio level conditions are detected: 
Silence and Over range.

AC3 Presence per channel Checks for the presence of AC3 encoded compressed 
audio data. 
Use this if AC3 audio data is expected on the channel.

Dolby E Presence per channel-pair Checks for presence of Dolby E encoded compressed 
audio data. 
Use this if Dolby E audio data is expected on the channel-
pair

PCM Presence per channel-pair Checks for the presence of PCM encoded (uncompressed) 
audio data. 
Use this if PCM audio data is expected on the channel-pair.

DialNorm Under per channel-pair Checks audio normalization levels.

Dolby E Config Changed per channel-pair Checks for a change in Dolby E configuration.
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Fig. 2-6:  Audio Alarms Control Screen
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Reference Alarms Control Screen
The Reference Alarms control screen allows the user to see the state of and to 
acknowledge MV-8 Series Multiviewer alarms relating to loss of input reference and to 
genlock source.

To acknowledge an alarm, select the corresponding Alarm Ack check box on the right-
hand side of the control screen.

Fig. 2-7:  Reference Alarms Control Screen 

Note: Alarms can be viewed and acknowledged on this control screen.

Multiviewer alarms are set up with the GV Orbit Client software 
application.

Note: To see the ‘Reference Input Lost’ (REFERENCE_1_STATE) and the 
‘Genlock Source’ (GENLOCK_1_STATE) alarm states in the Reference 
Alarms control screen, the corresponding ‘Unit Alarms’ in the GV 
Orbit multiviewer project running on the multiviewer must be 
enabled.

Otherwise, the alarms’ states are shown as: ‘-’
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Ancillary Alarms Control Screen
The Ancillary Alarms control screen allows the user to see the state of alarms and to 
acknowledge alarms related to the ancillary data for each multiviewer input.

All alarms sourced by the multiviewer can be monitored by GV Orbit and are available to a 
RollCall LogServer.

Fig. 2-8:  Ancillary Alarms Control Screen

1. Select Video Input channel being shown. 2. Acknowledge an alarm by selecting the corresponding 
Alarm Ack check box on the right-hand side of the control 
screen.

 Table 2-3:   Ancillary Data Alarms  

Video Alarm Description

CC1 Lost, CC2 Lost, CC3 Lost, CC4 Lost Loss of Closed Caption data

T1 Lost, T2 Lost, T3 Lost, T4 Lost Loss of Teletext data.

XDS Lost Loss of Extended Data Service information.

V-Chip Lost Loss of V Chip content rating information.

TSID Lost Loss of Transport Stream ID information.

CC608 Lost Loss of Closed Caption EIA 608 information.

DTVCC(608) Lost Loss of DTV Closed Caption EIA 608 data.

DTVCC(708) Lost Loss of DTV Closed Caption EIA 708 data.

VITC Lost Loss of Vertical Interval Time Code information.
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OP42 Lost Loss of OP42 Closed Caption information. 

OP47 Lost Loss of OP47 Closed Caption/Subtitling information. 

SMPTE2010 Lost Loss of SMPTE 2010 data.

 Table 2-3:   Ancillary Data Alarms  (continued)

Video Alarm Description

Note:
Alarms can be viewed and acknowledged on this control screen.

Multiviewer alarms are set up with the GV Orbit Client software 
application.
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Layout Control Screen 
Video walls are designed with the GV Orbit Client software tool. A wall may have one or 
more layout (alternative layouts) which may be selected.

The Layout control screen allows the user to select which wall layout to apply to each video 
wall on one or more multiviewer head display outputs. (Alternatively, a Grass Valley soft-
panel or hard-panel may also select wall layout, via the RollCall protocol)
Additionally, the on-screen transition type between one wall layout and the next can be set 
up.

The layouts are all contained within a GV Orbit multiviewer project which is pushed to the 
multiviewer unit.

The control screen also enables an output overlay feature to be enabled, which show 
information about the multiviewer inputs on the output screen and about the head display 
outputs themselves.

In a GV Orbit multiviewer project:
• Each video wall has a name property in the GV Orbit Client, set to “Wall 1”, “Wall 2” etc. 

by default. 
The wall name may be edited in GV Orbit Client by the user. It is shown on the Layout 
control screen. 

• Each wall layout has a name property in GV Orbit Client, set to “Layout1”, “Layout2” etc. 
by default. 
This layout name is editable in GV Orbit Client by the user. It is also reflected on the 
Layout control screen.

Note: These names are case-sensitive.
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On the Layout control screen, there is a Wall pane per video wall defined in the GV Orbit 
multiviewer project. See Figure 2-9.

Fig. 2-9: Layout Control Screen: a) Layout Control Screen; b) In GV Orbit.

 Table 2-4:   Wall Pane Settings  

Wall 1 ... up to Wall 12 Description

Wall N: Wall number, as defined in the GV Orbit multiviewer project. 
(1 ... up to 12.)

Wall name Wall name, as defined in the GV Orbit multiviewer project.

Outputs Head display output number(s) associated with the wall.

Layout Drop-down box. 
Select the wall layout to use from the drop-down list.

Wall pane

Applicable head display output(s)

Layout selection 
drop-down box

Wall name

Layout name

a) Layout Control Screen

b) In GV Orbit - Wall names, Layout 

Layout name

Wall names
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Overlays can be enabled on the head display outputs which show information about 
multiviewer inputs in video tiles on multiviewer outputs and about the head display 
outputs themselves.

In particular, the Output Overlay feature briefly shows extensive information after the 
Output Overlay feature is enabled. This includes IP addresses of the MV-8X0/8X1/8X5 
Multiviewer.

 Table 2-5:   Layout Transition Settings  

Setting Description

Layout Transition:

Fade Through Black Check box. 
Controls the type of on-screen transition seen when 
changing between wall layouts.

• Select for fade down to black, then fade up to new 
layout.

• Deselect for a cut from current to new wall layout.

 Table 2-6:   Overlay Settings  

Setting Description

Wall Designer Mode Overlay Information:

Controls the display of overlay information on each 
multiviewer head display output. See Figure 2-10.
(Multiviewer software 2.16.16 or later.)

Identify Inputs Check box. 
Select to display overlay information which identifies each 
video input on each video tile on the head display output 
screen.

Identify Outputs Check box. 
Select to display overlay information which identifies each 
head display output screen (1 ... up to 12). The overlay 
appears in the bottom right-hand side of each output.
Check box. 
Select to display overlay information which identifies each head display output screen (1 ... up to 12). The overlay appear in the bottom right-hand side of each output.

• Immediately after this Identify Output feature is 
enabled, the overlay information shown about the 
outputs is extensive. 
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om right-hand side of each output.

• After 20 seconds, the overlay then reverts to showing 
only brief output information, as shown in Figure 2-10.

Fig. 2-10: Multiviewer Head Display Output with Example Input and Output Overlays

 Table 2-6:   Overlay Settings  (continued)

Setting Description

Identify Outputs: Overlay identifies 
multiviewer display output

Identify Inputs: Overlay identifies a video 
input in a multiviewer video wall tile
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TSL Control Screen
The TSL control screen allows the user to select settings related to MV-8 Series Multiviewer 
support of the TSL protocol. 

TSL protocol is supported in TSL Server Mode or TSL Client Mode, see TSL Support, on 
page 96, Figure 5-2 on page 97.

For two types of Ethernet protocols (UDP and TCP), the user can separately set up IP address 
and network port information.

Remember to press the S button.

Fig. 2-11: TSL Control Screen

 Table 2-7:   TSL Mode Settings  

Setting Description

UDP:
Ethernet Interface Drop-down box. Select port 1 (1G1) or port 2 (1G2).

3.1 Port Text box. Network port to receive TSL 3.1 messages on. 
 Enter the network port number. 

5.0 Port Text box. Network port to receive TSL 5.0 messages on.
 Enter the network port number.

Mode Drop-down box. Select ‘Server’ mode, or ‘Disabled’.

TCP:
IP Address Text box.

In Server Mode: 
Enter local IP address of the MV-8 Series Multiviewer.

In Client Mode: 
Enter IP address of TSL Controller.

3.1 Port Text box. Network port to receive TSL 3.1 messages on. 
 Enter the network port number.

5.0 Port Text box. Network port to receive TSL 5.0 messages on.
 Enter the network port number.

Mode Drop-down box. 
Select ‘Server’ mode, ‘Client’ mode or ‘Disabled’.
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The GPIO control screen allows the user to set up settings related to the MV-8 Series 
Multiviewer unit’s GPIO interface. 

There are four GPIO ports, 1 to 4, on a MV-8X0/8X1/8X5 Multiviewer product. For connector 
pinouts, see the respective MV-8X0/MV-8X1/MV-8X5 product user manual.   

Fig. 2-12:  GPIO Control Screen

 Table 2-8:   GPIO port Settings.

Setting Description

GPIO 1 to GPIO 4:

Enabled Check box. 
Select to enable the GPIO port on the MV-8 Series Multiviewer 
unit.

Direction

Input 

Output

Radio buttons. 
Select the GPIO port to be an input or an output.

Selected: GPIO port is an input.

Selected: GPIO port is an output.

Active State

High

Low

Radio buttons. 
Select the active state of the GPIO port. 

Selected: Active state of the port is a high voltage.

Selected: Active state of the port is a low voltage.
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LTC Control Screen 
The LTC control screen allows a user to select an LTC source for the MV-8 Series Multiviewer 
multiviewer.

The following LTC sources may be selected:
• From Multiviewer.
• From Router.

See Table 2-9.

Note: This control screen is not applicable to standalone multiviewer 
products (which are not integrated into a router frame).

Fig. 2-13:  LTC Control Screen 

 Table 2-9:   LTC Source Radio Button Options  

Setting Description

LTC Source Radio buttons to select source of LTC for MV-8 Series Core 
Multiviewer.

From Multiviewer When selected, use the LTC signal applied to the multiviewer 
module rear panel.

From Router When selected, use the LTC information from the host router 
frame.

See Note 1.

Note 1: The host router’s controller configuration must have
 EmbeddedTimecodeEnable set to ‘True’. 

This is set in the Grass Valley WorkBench router configuration 
tool. Configuration item = 

Controller > Devices > LocalRouterDevice > 
LocalRouterConfig > EmbeddedTimecodeEnable

See Figure 2-14.
37



Core MV Control Screens
LTC Control Screen
Fig. 2-14: EmbeddedTimecodeEnable Router Controller LTC Source Configuration Item

(WorkBench tool screenshot)
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Timer Control Screen
The Timer Control screen allows a user to set up timers used in widgets on a video wall and 
then remotely control the timers. Timers may also then be remotely started or stopped 
controlled with RollCall soft-panels or hard-panels.

 

Note: All Timer widget styling and configuration of trigger points etc. are 
set through the GV Orbit Client application.

Fig. 2-15:  Timer Control Screen

 Table 2-10:    Timer Control Settings  

Setting Description

Timer 1 to Timer 16:

Running Check box. 
Select to start the timer. Deselect to stop.

Reset Check box. 
Select to reset the timer. The check box automatically is 
deselected when the timer has reset.

Text box Enter the timer’s target time. Target time format: HH:MM:SS
For example, 12:30:00

Note: When the target time is changed, the timer is reset. 
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Remember to press the S button.

Count Up Radio button. 
Select to reset the timer and count up.

Count Down Radio button. 
Select to reset the timer and count down.

 Table 2-10:    Timer Control Settings  (continued)

Setting Description
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Timer Request Protocol Control Screen 
The Timer Request Protocol control screen allows a user to define the IP address of an 
“eTimer” server device and the IP port number to use. 
The protocol used is the PluraTM timer request protocol.

Remember to press the S button when changing the IP Address settings.

Fig. 2-16:  Timer Request Protocol Control Screen 

 Table 2-11:    Timer Request Protocol Settings

Setting Description

IP Address Enter IP Address of an ‘eTimer’ server device.

Port Enter IP port number to use for Timer Request Protocol messages.

Enabled Check box. 
Select to enable use of Timer Request Protocol messages.

Note: “S” and “P” buttons - After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally save 
the new setting. Do this for each text box. (Note: Clicking on the “P” 
button will return the setting to its preset default value).

“S” - Locally save new setting value (or press “return”).

“P” - Locally save default setting value.

Note: Configuring a Timer Widget for eTimer:

A Timer widget is configured on a video wall tile with the GV 
Orbit Client application. It can be configured to be connected to 
an eTimer service.
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Biometrics Setup Control Screen 
The Biometrics Setup control screen sets up the multiviewer’s media biometric generators 
(MBGs) on a per multiviewer input basis. Each of the 48 inputs has an MBG which can 
produce a video and audio signature from the media at the corresponding input. 

Each multiviewer input’s MBG is separately configurable and is assigned a name on a per 
input basis which is user-editable. The name identifies a signature when it is checked and 
verified (media assurance). 

Fig. 2-17:  Media Biometrics Control Screen 

 Table 2-12:    Media Biometrics Settings  

Setting Description

Domain ID RollCall domain ID for media biometrics signature messages.

Domain ID Text box.
Enter RollCall+ domain ID. Press S to save value.

Note 1: Set the Domain ID to be the same as the one used by 
the media assurance system, for example Grass Valley SigMA.

Note 2: Use a different Domain ID value from the RollCall 
Settings domain ID, set up in the System-Setup Control 
Screen. 
(See “RollCall Settings” box on page 21.)

Generator Setup
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Active Video Displays which video inputs have media biometrics generators 
(MBGs) enabled. 

Video Input 
Select

Check box. 
Select the video input to configure. 

Enabled Check box.
Select to enable the MBG at the selected input. 

Name Text box.
Name for the media biometrics generator (MBG) at the selected 
input. Defaults to the video input name, e.g. ‘Video Input 6’. 
The name is user editable.

Enter a unique name for the MBG if required. Press S to save the 
value.

Note: A name identifies a signature’s video input source, useful 
in a media assurance system.

Audio Channels Check boxes for audio channels 1 to 32.
Select the audio channel signatures required.

Note: “S” and “P” buttons - After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally save 
the new setting. Do this for each text box. (Note: Clicking on the “P” 
button will return the setting to its preset default value).

“S” - Locally save new setting value (or press “return”).

“P” - Locally save default setting value.

 Table 2-12:    Media Biometrics Settings  (continued)

Setting Description
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HDR Setup Control Screen
The HDR Setup control screen sets up the multiviewer’s HDR/SDR conversions on a per 
multiviewer video input or per head display output basis. Each of the 48 inputs has a HDR-
SDR conversion block which can convert an HDR input into an internal SDR signal. Each of 
the 12 head display outputs has an SDR-HDR conversion block which can convert a the 
internal SDR output signal to HDR for output. 

Fig. 2-18: HDR Setup Control Screen

Each of the 48 video inputs may be set up individually or all together (ganged). See 
Figure 2-19a and b.

Each of the 12 head display outputs may be set up individually or all together (ganged). See 
Figure 2-19c and d.
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Fig. 2-19: HDR Setup Controls: 
a) Video Inputs.
b) Ganged.
c) Head Display Outputs.
d) Ganged.

a) Video Input HDR Settings b) Video Input HDR Settings (Ganged)

c) Head Display Output HDR Settings d) Output HDR Settings (Ganged)

 Table 2-13:   HDR Setup Settings  

Setting Description

Inputs: Configure settings for each input here.

Gang Check box.
Select to setup up HDR on all inputs together.

LUT Drop-down box.
Select dynamic range of video input.
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Primary Drop-down box. 
Select the color space of the video input.

Nits Text box. 
Enter the Nits value for the HDR to SDR conversion.

See Nits, on page 77, for information about this setting.

Outputs: Configure settings for each output here.

Gang Check box.
Select to setup up HDR on all outputs together.

LUT Drop-down box.
Select required dynamic range of head display output.

Primary Drop-down box. 
Select the required color space of the head display output.

Nits Text box. 
Enter the Nits value for the SDR to HDR conversion.

See Nits, on page 77, for information about this setting.

Note: “S” and “P” buttons - After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally save 
the new setting. Do this for each text box. (Note: Clicking on the “P” 
button will return the setting to its preset default value).

“S” - Locally save new setting value (or press “return”).

“P” - Locally save default setting value.

 Table 2-13:   HDR Setup Settings  (continued)

Setting Description
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Audio Codec Select Control Screen
The Audio Codec Select control screen selects optional audio channel(s) to be compressed 
for each ‘input-copy’ RTSP stream. The audio stream and the corresponding input video 
H.264-compressed stream are wrapped into a RTSP stream. (Requires the ‘H264 stream’ 
license.)

This feature applies to MV-8X1 multiviewer products only.

For each of the 48 video inputs, a mono audio channel can be selected from the first 8 
stereo audio pairs. This can be the left- or right-audio channel of the pair, or a stereo down-
mix.
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Fig. 2-20: Audio Codec Select Control Screen

Note:
A mono audio can be set up for each multiviewer video input. Settings are for 
the 48 inputs. They do not reflect any quad-link input associations that might 
be applied in the multiviewer.
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Fig. 2-21: Audio Channel Selection

1 De-select to enable the audio codec for this 
audio channel.

2 Select stereo pair.

3 Select audio from the pair:
• Stereo (i.e. a down-mix);
• Left; or 
• Right.
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Introduction
Input alarms for each input of a core MV-8 Multiviewer are set up in the GV Orbit Client 
application. With a GV Orbit ‘multiviewer project’, the alarm setting is found under the 
‘Multiviewer > Input Alarms’ main menu item. All the alarms for each multiviewer input 
need to be configured in the GV Orbit project: Input alarms can be set up and enabled for 
one multiviewer input, and then those settings can be copied to other inputs. Finally, the 
project needs to be pushed to the core MV-8 Series Multiviewer for the setting changes to 
take effect.

Input Alarms Dialog
Enable and configure input alarms with the Input Alarms dialog. With a multiviewer 
project open in GV Orbit Client:

1 Select ‘Multiviewer > Input Alarms’ in the main menu.

The Input Alarms dialog is shown.

Fig. 3-1: Input Alarms Dialog

The dialog contains the following tabs: Input, Alarm, Levels, Audio 1-16, and Audio 17-
32.
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Overview of Configuring Input Alarms
This is the procedure for configuring input alarms:

1Select a multiviewer input (Selected Input) in the Input tab.
2Configure alarms for the selected input (for example, for frozen video, video presence, 

audio levels etc.); this is done using the other tabs, see Table 3-1. 
(The following sections describe each tab of the Input Alarms dialog.)

3Then set up alarms for all other multiviewer inputs. 
To help, alarms settings for one input may be copied to other inputs.

 

4Click OK to save the changes and close the Input Alarms dialog.
5Save the GV Orbit multiviewer project.
6For alarm setting changes to take effect on a unit, the GV Orbit project must be pushed 

to the multiviewer unit.

The following sections describe each tab of the Input Alarms dialog.

Note: Alarm settings for one input can be copied to other inputs; this is 
useful if the same settings are needed for several inputs.

 Table 3-1:   Input Alarms Dialog Tabs

Input Alarms 
Dialog Tab

Description

Input Enables a user to:
•Select the multiviewer video input to be configured for alarms.
•Copy input alarms settings from one input to one or more other inputs.

See Input Tab, on page 54.

Alarm Enable and configure alarms on video inputs and for the multiviewer unit. 

See Alarm Tab, on page 56.

Levels Separate tab for configuring some audio alarm properties.

See Levels Tab, on page 64.

Audio 1-16,
Audio 17-32

Separate tab for configuring some extended audio alarm properties.

See Audio 1-16 and Audio 17-32 Tabs, on page 65.
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Input Tab
The Input tab of the Input Alarms dialog has two functions. It allows the user to:

•Select a multiviewer input to be configured for alarms, see Figure 3-2 on page 54.
(See Selecting a Multiviewer Input to Configure, on page 54.)

•Copy input alarm settings from one input to one or more other inputs, see Figure 3-3 on 
page 55.
(See Copying Input Alarm Settings to One or More Other Inputs, on page 55.)

Selecting a Multiviewer Input to Configure

Fig. 3-2: Selecting an Input

When an input is selected, all alarm settings for the selected input can be configured using 
the other tabs in the Input Alarms dialog. 

Input Selection list box:
The list box is used to 
select the multiviewer input 
to be configured for alarms.



To select an input:

• Click on an input name to 
select an input.

The selected input appears 
in the Selected Input box 
below.

The Selected Input drop-down 
box displays the selected input 
on each tab.

The Selected Input can also be 
changed at this drop-down box 
on any tab.

Note: The Selected Input may be changed on any tab.

CAUTION The Selected Input may be changed on any tab. 
Do not unintentionally change this setting.
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Copying Input Alarm Settings to One or More Other Inputs
This sub-section describes copying input alarm settings from one input to one or more 
other inputs. Settings can be copied to all inputs or to a selection of inputs. When one input 
has all of its alarm settings fully configured (i.e. all tabs in the Input Alarms dialog have 
been set up for that input), copy its alarm settings to one or more other inputs.

Figure 3-3 describes the copying action.

Fig. 3-3: Copying Alarm Settings 

Note: Copying alarm settings from an input to one or more other 
input(s) will overwrite all the alarm settings for those input(s).

1) Check that the Selected Input is correct.

To select which inputs to copy to:

2) In the Copy to Input Selection list box: 
• Click on an input item to select it. 
• Select multiple inputs by clicking on each item in 

turn.
•To remove an item from your selection,

(re-)click on the item.
•To clear the whole selection, click Clear Selection.




When a ‘Copy to’ selection has been made:

3) To copy alarm settings from the Selected Input 
to the ‘Copy to’ selection, click Copy Selection.

The Selected Input to copy from is shown here.

Caution: Always check that the correct input is 
selected before copying alarm settings.

Copy to Input Selection list box

Or:

4) To copy alarm settings from the Selected Input to all of the inputs, click Copy All.

 This copies alarm settings to all of the inputs.

CAUTION 
Selected inputs in the ‘Copy to Input Selection’ box will 
have their alarm settings overwritten.
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The Alarm tab in the Input Alarms dialog allows one or more audio, video and ancillary 
data alarms to be enabled and set up for the Selected Input. Alarm properties can be 
viewed and settings changed.

Fig. 3-4: Selecting an Alarm

There are basic alarm properties which are common to all alarms and additional alarm 
properties for some specific alarms. Further, there are extended alarm properties for audio-
based alarms. See Alarm Tab - Basic Alarm Properties, on page 57, and Alarm Properties, on 
page 59 for more information.

Select Alarm list box.





Setting up alarms for one input:

1) Click on an alarm item in 
the list box to select it.

The selected alarm is 
 highlighted 
and its alarm properties are 
shown on the right,
in the Properties box.

2) To set up the alarm’s 
properties, see Table 3-2.

Basic properties of the selected 
alarm. See Table 3-2.

Selected Input is displayed here and it may be changed here.
56



MV-8 Series Multiviewer
User Manual
Alarm Tab - Basic Alarm Properties
The basic properties are shown in Figure 3-4 on page 56.

Note: Alarms are enabled in the tab on a per input basis.
For example, disabling the Audio PCM Lost alarm for input 2 
disables the checking for the presence of PCM audio on all audio 
channels of input 2 only.
To affect other inputs, copy alarm settings from one input to one or 
more other inputs.

 Table 3-2:   Basic Alarm Properties  

Property Description

Alarm Enable Check box. 
Select to enable the selected alarm for the Selected Input.

Enabling/disabling applies per Selected Input.

Note: Once an alarm is enabled, it is shown underlined and in bold in the Select 
Alarm list.

Note: Alarm Enable enables or disables an alarm type on a per input basis.

Delay 
(Seconds)

Text box (located below Alarm Enable check box). 
The time in seconds: 

• from when a fault is detected;
• to when the alarm is displayed on the multiviewer video wall. 

This sets up a small delay to prevent transient alarms being displayed - filtering out 
transient alarms.

Automatic 
Acknowledgment

Check box. 
• Select to enable the selected alarm to be automatically acknowledged by the 

multiviewer system. 
• De-select to manually acknowledge alarms. 

Alarms will have to be acknowledged by the user, to stop an alarm flashing.

Delay 
(Seconds)

Text box (located below Automatic Acknowledgment check box). 
The time in seconds:

• from when the alarm occurs;
• to when it is automatically acknowledged by the multiviewer system. 

Set up a delay to allow an alarm to flash and be displayed for a short time before 
being automatically acknowledged.
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Selected Alarm List
All alarm types for the Selected Input are listed in the Select Alarm box. When alarms are 
enabled for the Selected Input, they are underlined in the Select Alarm box. See Figure 3-5.

Fig. 3-5: Select Alarm List - Enabled Alarms for the Selected Input

Enabled alarms (for the Selected Input) 
are shown underlined and bold 
in the Select Alarm list.

Selected Alarm

Selected Input
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Alarm properties depend on the alarm type. There are the following classes of alarm 
properties: 

• Basic Alarm Properties
• Additional Alarm Properties
• Extended Alarm Properties

Basic Alarm Properties
Alarm Tab - Basic Alarm Properties, on page 57, are common to all alarms and are shown on 
the Alarm tab, in the Properties box. 

Additional Alarm Properties
Some alarms have additional properties which are also shown in the Properties box. 
For example, ‘Video Black’, or ‘Video Freeze’ alarms. 

See Additional Properties of Video Input Alarms, on page 60.

Extended Alarm Properties
Some alarms have extended properties which also involves the Levels, Audio tabs of the 
Input Alarms dialog. A message appears at the Properties box in the Alarm tab. See 
Figure 3-6.

Fig. 3-6: Example - Audio Level Properties Box and Message

For example, 
audio alarms have extended settings for each audio channel of the Selected Input. These 
separate tabs are covered in separate sub-sections in this manual. See:

• Levels Tab, on page 64.  
• Audio 1-16 and Audio 17-32 Tabs, on page 65.

Message at the Properties box instructing 
that some extended input alarm properties 
must be configured in separate tabs.
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Additional Properties of Video Input Alarms
Some video input alarms have specific additional properties. These are covered here and 
include:

•Additional Properties - Video Black Alarm, on page 60.
•Additional Properties - Video Freeze Alarm, on page 61.
•Additional Properties - Video Stillish Alarm, on page 61. 
•Additional Properties - Video Input Format Change Alarm, on page 63. 

Additional Properties - Video Black Alarm

Fig. 3-7: Video Black Alarm - Additional Properties

See Table 3-3 on page 62 for a description of the additional alarm properties.

Informative 
message
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Additional Properties - Video Freeze Alarm

Fig. 3-8: Video Freeze Alarm - Additional Properties

See Table 3-3 on page 62 for a description of the additional alarm properties.

Additional Properties - Video Stillish Alarm

Fig. 3-9: Video Stillish Alarm - Additional Properties

See Table 3-3 on page 62 for a description of the additional alarm properties.

Informative 
message

Informative 
message
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Video Black, Freeze, and Stillish Alarm Properties
The properties described in Table 3-3 relate to Figure 3-7 on page 60, Figure 3-8 on page 61, 
and to Figure 3-9 on page 61.

 Table 3-3:   Video Black, Freeze and Stillish - Additional Alarm Properties  

Property Description

Dark.....Light Slider bar. 
Sets the on-screen dark level, below which the Video Black alarm is 
triggered.

Low.....High Slider bar.
Sets the on-screen movement level deemed to be a “frozen picture” for the 
Video Freeze alarm.

Moving.....Still Slider bar.
Sets the on-screen movement level for the Video Stillish alarm to be 
triggered.

Detector Window: An on-screen area where an alarm detector operates.

X Position Slider bar. 
Defines horizontal start position of left-hand edge of a rectangular on-screen 
area.

Width Slider bar. 
Defines horizontal size of a rectangular on-screen area.

Y Position Slider bar. 
Defines vertical start position of top edge of a rectangular on-screen area.

Height Slider bar. 
Defines vertical size of a rectangular on-screen area.

Full Screen Button.
Click to set rectangular area to be full screen.

Mode: Radio buttons: 
Defines in which region on-screen to detect in, 
i.e. within or outside a rectangular on-screen area defined above.

Used for video image-related alarms. For example, video black.

 Inside Window Select to detect inside the rectangular on-screen area.

 Outside Window Select to detect outside the rectangular on-screen area.
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Additional Properties - Video Input Format Change Alarm 
The additional properties for this alarm are not shared by another video alarm.

Fig. 3-10: Video Input Format Change Alarm - Additional Properties

Table 3-4 Video Input Format Change - Alarm Properties

Property Description

Expected Format List box. 
Click on one video format in the list to select the expected 
video input format. 
The alarm alerts the user to any difference between the 
video format detected at an input and the expected format.

Note: The Video Input Format Change alarm is commonly 
used as a “format-mismatch-from-expected” alarm.

Selected Expected Format
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Levels Tab
This Input Alarm dialog tab presents some Extended Alarm Properties associated with 
some audio alarms. 

The Levels tab sets audio trigger levels for input alarms associated with the Selected 
Input. The same trigger levels are used for all audio channels of the Selected Input. 
(The Selected Input is shown at the bottom of the tab.)

Fig. 3-11: Levels Tab

Note: The same audio level settings are used for all audio channels on 
the Selected Input.

 Table 3-5:   Levels Tab Properties  

Property Description

Audio Silent Level Slider bar. 
Sets the audio level below which the audio silence alarm 
triggers. Range -99 to -60 dBFS

Audio Overload Level Slider bar. 
Sets the audio level above which the audio overload alarm 
triggers. Range -15 to 0 dBFS

Dialnorm Under Threshold Slider bar. 
Sets the Dialnorm (Dialog Normalization) threshold audio 
level below which the Dialnorm Under Alarm is triggered. 
Range 1 to 31 dBFS

Selected Input Text drop box. 
Displays the selected input, repeated on each tab. 
The Selected Input may also be changed here.

Caution: Do not change the selected input unintentionally.
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Audio 1-16 and Audio 17-32 Tabs

Introduction
These Input Alarm dialog tabs presents some embedded-audio, channel-specific Extended 
Alarm Properties associated with input audio alarms for the Selected Input. There are two 
similar tabs: 

•Audio 1-16 - sets up input audio channels 1 to 16.
•Audio 17-32 - sets up input audio channels 17 to 32.

Audio alarms are set up on a per mono-channel or per channel-pair basis, depending on 
the type of alarm. Alarms are set up per multiviewer input (i.e. Selected Input).

Each audio alarm must first be enabled in the Alarm tab before its channel properties can 
be modified in the Audio 1-16 and Audio 17-32 tabs. See Alarm Tab - Basic Alarm 
Properties, on page 57.

Setting up Audio Channel Alarms
To set up audio channels for one or more audio alarms on a multiviewer input:

1Select the input. 
(Do this either in the Input Tab, or in the Selected Input drop-down box.)

2Select and enable the required audio alarms in the Alarm Tab. 
(See Alarm Tab - Basic Alarm Properties, on page 57.)

3In the Audio 1-16 and Audio 17-32 tabs, settings can be modified on a per-channel 
basis for enabled alarms. 
(See Audio Channel Tabs, on page 65.)

Audio Channel Tabs
The audio alarm types covered by the Audio 1-16 and Audio 17-32 tabs are shown in 
Figure 3-12. There is a column for each alarm type. Audio channels are shown in rows. 
Columns are grayed-out if the corresponding alarm is not enabled in the Alarms tab.

Note: The Selected Input is shown on the tab in a drop-box and may be 
changed on the tab. 

CAUTION 
Do not inadvertently change the Selected Input here. 

Note: Columns are grayed out unless the alarm has been first enabled 
on the Alarms tab.
65



Core MV Input Alarms
Audio Channel Tabs
Fig. 3-12: Audio Tab (Audio 1-16 shown)

The Audio 1-16 and Audio 17-32 tabs are similar and are further shown in Figure 3-13 and 
their various alarm properties are described in Table 3-6 on page 68.

Alarms covered 
by the tab.

(Enable an alarm in the Alarm tab 
to ‘ungray’ its column.)
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Fig. 3-13: Audio 1-16 and Audio 17-32 Tabs

Audio Level column is active, not grayed-out,
indicating Audio Level alarm is enabled.

AC3 Lost column is inactive, grayed-out,
indicating AC3 Lost alarm is not enabled.

Click All to select all channels 
in the column

Click None to de-select all channels 
in the column

One column per audio alarm type.

Selected Input 

One row per audio channel.
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 Table 3-6:   Audio 1-16 and Audio 17-32 Tab Properties  

Property
(Column Heading)

Description

Audio Level Check box, per embedded audio channel.
Select to enable the Audio Level alarm for the channel. 

Audio channels may be selected individually or
all channels can be selected/deselected by clicking the All / None button at 
the base of the column.

AC3 Lost Check box, for audio channels in pairs. 
Select to enable the AC3 Lost alarm for the channel pair. 

Audio channels are selected in pairs or all channels can be selected by 
clicking the All / None button at the base of the column.

PCM Lost Check box, for audio channels in pairs.
Select to enable the PCM Lost alarm for the channel-pair. 

Channels are selected in pairs, or all of the channels can be selected/de-
selected by clicking on the All / None button at the base of the column.

Dolby E Lost Check box, for audio channels in pairs. 
Select to enable the Dolby E Lost alarm for the channel-pair. 
(Only available if the input’s Dolby E Lost alarm is enabled in the Alarms 
tab.)

Channels are selected in pairs, or all of the channels can be selected/de-
selected by clicking on the All / None button at the base of the column.

Dolby E Config Changed Check box, for audio channels in pairs. 
Select to enable the Dolby E Config Changed alarm for the channel-pair. 
(Only available if the input’s Dolby E Config Changed alarm is enabled in the 
Alarms tab.)

Alarm alerts the user to a change in Dolby E audio channel configuration 
expected on an audio channel pair, for example “5.1 + 1 + 1” changing to “5.1 
+ 2”.

The expected Dolby E Configuration is set up in the adjacent Expected 
Dolby E Config drop-down box.

Channels are selected in pairs or 
all of the channels can be selected/de-selected by clicking on the All / None 
button at the base of the column.
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Expected Dolby E Config Drop-down list. 
Select the Dolby E configuration to be expected on the audio channel-pair. 
The Dolby E configurations selectable are shown below:

DialNorm Under Check box. 
Select to enable the DialNorm Under alarm for the audio channel-pair. 

Alarm monitors if the dialog normalization value, described in metadata, is 
below the level set up in the alarm properties, Input Alarms dialog, Levels 
tab.

(Only available if the input’s DialNorm Under alarm is enabled in the Alarms 
tab.) 

Channels are selected in pairs or all of the channels can be selected/de-
selected by clicking on the All / None button at the base of the column.

 Table 3-6:   Audio 1-16 and Audio 17-32 Tab Properties  (continued)

Property
(Column Heading)

Description
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All / None Toggle buttons. Located at the bottom of each alarm type column.

Click on the All button to select all entries in that column. 

Click on the None button to deselect all items in that column. 

Selected Input text box Displays the selected input, repeated on each tab.
The Selected Input may also be changed here.

 Table 3-6:   Audio 1-16 and Audio 17-32 Tab Properties  (continued)

Property
(Column Heading)

Description
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Section contents:
Core MV Input-Copy H.264 Streams
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Control Settings ..................................................................................................................  page 73

Stream URLs ..............................................................................................................  page 73
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Viewing H.264 Input-Copy Streams ...............................................................................  page 74
Media Player Example ............................................................................................  page 74
GV Orbit Client Examples .......................................................................................  page 77

Latencies ...............................................................................................................................  page 91

This chapter describes an MV-8 Series Multiviewer’s H.264 ‘input-copy’ feature. 

Note:
An MV-8X1 multiviewer requires a ‘H.264 stream’ license. For example, 
license ‘MV-821-H264’.
For MV-801, MV-831, and MV-841/851 multiviewers, the license can be 
added in the field.
However, an MV-821 multiviewer (MV-821-HDBNC or MV-821-IP) requires 
a factory-fitted hardware option to use with this license.
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Introduction
The MV-8 Series Multiviewer supports sending out H.264-compressed copies of video 
inputs on a control network interface for displaying on a PC screen as a simple confidence 
monitor facility using Grass Valley’s GV Orbit Client application (product: GV Orbit Lite) or a 
suitable media player application. 

Each MV-8 Series Multiviewer video input image is scaled-down and compressed to create 
an H.264-encoded ‘input-copy’ stream. For each video input, an audio channel can also be 
selected and compressed into an accompanying audio stream. The image and audio 
streams are transmitted on a control network interface of the multiviewer unit. They are 
transmitted as an RTSP stream (one stream per multiviewer input) and may be viewed on a 
PC for thumbnail/confidence-monitoring applications.

Fig. 4-1: Multiviewer Video Input Block Diagram - Input-Copy RTSP Streams

Each RTSP stream is a wrapper for:
• an H.264-compressed image stream; and 
• an optional (compressed) mono audio channel selected from audio channels of the 

video input. (MV-8X1 multiviewers only.)

Note: Audio only available in MV-8X1 multiviewers.

Note: Recommended maximum number of streams:
MV-8 Series multiviewers can potentially source an RTSP ‘Input-Copy’ H.264 
video stream for each multiviewer video input. 
In practice, in order to minimize image artifacts for real-world video signals, 
it is recommended a maximum of 30 streams is sourced from any one 
multiviewer.
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Control Settings
The following ‘Input-Copy’ stream settings are defined on the System - Setup control 
screen, see System-Setup Control Screen, “Streamed Output” box, on page 22:

• Ethernet interface to use.
• IP port number.
• Specific Multicast Group Base Address, if required.
• Global-enable of all streams.

Audio channel selection is done in the Audio Codec Select Control Screen, on page 47. For 
each video input, a single mono audio channel can be selected to be either:

• any left- or right-audio channel; or 
• a down-mix of any stereo pair. 

Stream URLs
Each stream has the same stem URL and video inputs 1 to 48 have suffices ‘/Stream1’ to ‘/
Stream48’ respectively.
For example: 

Stream IP Ports
An IP Port number is defined in the System-Setup Control Screen, “Streamed Output” box, 
on page 22. For example, 8554. The IP Port number used for H.264 ‘input-copy’ streams is 
different between MV-8X0 and MV-8X1 devices:

• For MV-8X0 multiviewers - The defined IP port number is used for all 48 streams. 
For example, 8554.

• For MV-8X1 multiviewers - The defined IP port number is used for the first 12 streams; 
for the next 12 streams, the IP Port number used is incremented by one; and so on. 
For example: 

rtsp://10.162.51.200:8554/Stream10

IP Address   IP Port number   video input 10 suffix

Streams IP Port

1 - 12 8554

13 - 24 8555

25 - 36 8556

37 - 48 8557
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Viewing H.264 Input-Copy Streams

Media Player Example
To view an H.264 ‘input-copy’ stream in a media player:

Step 1: Prepare Multiviewer 
1 License the MV-8X1 multiviewer device for H264 streaming.
2 Apply video inputs to the multiviewer unit.

In the multiviewer’s System-Setup control screen, in the Streamed Output section:
3 Select the Ethernet Interface to use for the streams.

Fig. 4-2: Streamed Output Settings

4 Leave IP Port number at its default (8554), 
unless the port number needs to change for some reason.

5 Leave the Multicast Group Base address blank,
unless a specific base address is required.

6 Select Enable.

All H.264 stream outputting is enabled. 

All multiviewer RTSP H.264 ‘Input-Copy’ streams are now ready to be sent out. A stream is 
only sent out from the MV-8 Series Multiviewer when another device/application (for 
example, a media player) has opened the RTSP stream for viewing.

Step 2: View in a Media Player
1 Open the media player of choice. VLC is used in this example.
2 Open the RTSP media stream on the network.

Note: 
H.264 ‘input-copy’ streams are only sent when a device is receiving the RTSP 
stream.
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Fig. 4-3: Open Media Stream

3 Click Play.

The media is shown in the player window.

Enter URL of stream. 
For example,
RTSP://10.162.51.166:8554/Stream48

Click Play.
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Fig. 4-4: Playing H.264 ‘Input-Copy’ Stream
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Fig. 4-5: Codec Information 

GV Orbit Client Examples
To view an H.264 ‘input-copy’ stream in a video tile in GV Orbit Client, a video tile on a GV 
Orbit screen needs setting up to show streamed video from some URL.

For this, the following must be known:
• IP address of the multiviewer.
• The IP port number(s) it is using for its H.264 ‘input-copy’ streams.

The client PC being used must have network access to the RTSP stream source device.

Set up A Multiviewer
See Step 1: Prepare Multiviewer, on page 74 to set up a multiviewer for ‘Input-Copy’ 
streaming.
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GV Orbit Custom User Panel Example
This example will describe how to view an H.264 ‘Input-Copy’ stream on a custom user 
panel. This is for a GV Orbit Professional or Enterprise user. To run a GV Orbit custom user 
panel, a GV Orbit system is required with a GV Orbit server:

1 Open GV Orbit Client.
2 Create a new ‘C&M’ project.
3 Create a new screen. 

This will be the custom user panel.

Note: The GV Orbit Client should be in ‘Design Mode’ (see tool bar icon in Figure 4-6).
4 Click once on the Video Stream widget icon at the bottom of the screen, see Figure 4-

6.

Then move the cursor to bring a Video Stream widget onto the custom user panel. 
Position the widget on the panel and click once to release it.

Fig. 4-6: Adding Video Stream Widget

5 Select the widget on the panel and edit the Video > Source Path widget property: 
Enter the RTSP stream URL. (See Figure 4-7.)

Click once on Video Stream icon. Note: Icon shows ‘Design Mode’.

Bring a Video Stream widget 
onto the custom user panel
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Fig. 4-7: Enter URL for Video > Source Path Property

6 Click the ‘Run Mode/Design Mode’ tool bar icon. See Figure 4-8.

The custom user panel is run and video appears as a live thumbnail image in the 
widget. See Figure 4-8.

Fig. 4-8: Run Custom User Panel

Enter H.264 stream URLVideo > Source Path property

‘Run Mode/Design Mode’ Tool Bar Icon (showing ‘Run Mode’)
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GV Orbit Lite Example
For GV Orbit Lite product users, there is just the GV Orbit Client tool, no GV Orbit server nor 
C&M project. The example uses just the GV Orbit Client tool and is also applicable to the GV 
Orbit Professional and Enterprise products. 

The example below will build a small desktop video wall and configure one tile to show an 
H.264 stream.

Step 1: A Simple Desktop Video Wall
1 Run GV Orbit Client and create a New Project, a multiviewer project.

.

Fig. 4-9: Creating a New Multiviewer project

2 Click Next.
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Fig. 4-10: Creating a New Multiviewer project

3 Select ‘Output Size’ 1920x1080.
And click OK.

4 Click the Walls icon and click New Wall. See Figure 4-11.
.

Fig. 4-11: Creating a New Wall

5 Enter a Name for the new wall.
Click OK.

A new video Wall is shown.
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6 Click the Run Mode/Design Mode tool bar icon to set GV Orbit Client into ‘Design 
Mode’. (Note: Clicking this icon toggles between the two modes.)

The new video wall is shown in the Wall Editor. See Figure 4-12.
.

Fig. 4-12: New Wall in Wall Editor

7 Click the ‘Assign Outputs to Wall’ button ( ) in the bottom right-hand corner. 
8 Click on the 3x3 Grid to populate the new video wall with a 3x3 grid.

Run Mode/Design Mode icon, showing GV Orbit Client in ‘Design Mode’.

Assign Outputs 
to Wall button
82



MV-8 Series Multiviewer
User Manual
.

Fig. 4-13: Setting a 3x3 Grid in Wall Editor

9 Select a video tile on the Wall.
10 Find the Streaming Video property and set it to ‘True’.

Assign Outputs 
to Wall button

Click on a 3x3 
grid
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Fig. 4-14: Streaming Video True

11 Click the Save Project icon in the tool bar ( ) to save the Wall design.

The basic preparation of a simple desktop video wall is done and is now saved. One video 
tile on the wall has been set up for displaying RTSP ‘Input-Copy’ video stream.

Step 2: Point GV Orbit Client at a Multiviewer

To point the GV Orbit Client multiviewer project at a multiviewer unit:
12 Click Multiviewer -> Properties in the main menu.

The Properties dialog is shown. See Figure 4-15.

Streaming Video 
property value set to True

Selected Tile
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Fig. 4-15: Properties Dialog

In the Properties dialog:
13 Enter the IP address of a multiviewer sourcing H.264 ‘Input-Copy’ streams.
14 Click Apply.

A connection is made to the multiviewer device and this is indicated at the bottom of 
the GV Orbit Client screen. See Figure 4-16.

.

Fig. 4-16: Properties Dialog

Some further multiviewer settings are then filled out automatically in the dialog. 
(E.g. RollCall Network, Domain ID and Routing Service address.)

15 In the ‘Streamed Output’ section of the Properties dialog (see Figure 4-15):
1 Enter the IP address of the network interface used by the multiviewer for the H.264 

Input-Copy streams.

Properties DialogClick Multiviewer -> Properties

IP address of 
multiviewer

‘Streamed Output’ 
section

Connection to Multiviewer
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2 Enter the IP port number used by the multiviewer for the H.264 Input-Copy 
streams.

16 Click OK.

A dialog pops up advising that the ‘Streamed Output’ changes mean the Wall editor 
will need to be closed (so any unsaved Wall design needs saving first). 

.

Fig. 4-17: Properties Dialog Pop-up

17 Click Yes.

The Wall Editor is closed and the multiviewer property settings are applied to the GV 
Orbit project and the multiviewer ‘Input-Copy’ stream URLs are formed.

Step 3: View the Video Wall

Re-Open the Wall:
18 Click on the Walls icon 

and select the new wall design in the list.

Note: The Wall design has already been saved in the steps above. 
If it had not been, then the new Wall design would be lost.

Pop-up
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Fig. 4-18: Re-Open Wall

The wall design is opened in ‘Run Mode’. One video tile shows video from a RTSP video 
stream. See Figure 4-19.
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Fig. 4-19: Wall Running and Showing a Video Stream

To change the video input being shown by the video tile:
19 Click the Run Mode/Design Mode icon 

to stop running the wall and show it in the Wall Editor.
20 Select the video tile.
21 Change the Configuration -> Input property in the Properties box to select another 

video input. See Figure 4-20a.

The resulting video stream path is filled out from the video input number selected and 
the IP address/IP port information. See Figure 4-20b.

Run Mode/Design Mode icon
88



MV-8 Series Multiviewer
User Manual

r. 
ing 
.

Fig. 4-20: Select a Video Input:
a) Select video input to show on video tile.
b) Resulting RTSP video stream path.

22 Click the Save Project icon in the tool bar ( ) to save the Wall design.
23 Click the Run Mode/Design Mode icon 

to start running the wall. The newly-selected video is now shown on the screen. See 
Figure 4-21.

Properties box

a) Select video input to show on video tile.

b) Resulting RTSP video stream path.

Note: RTSP video stream path is shown for an MV-8X0 multiviewe
An MV-8X1 multiviewer uses one of four IP port numbers, depend
on the multiviewer video input (see Stream IP Ports, on page 73).

Selected video tile
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Fig. 4-21: Wall Running and Showing a New Video Stream

Run Mode/Design Mode icon
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An MV-8 Series Multiviewer can generate up to 48 RTSP streams which are scaled, H.264-
compressed copies of its multiviewer inputs. These streams are viewable on a networked 
PC running a suitable viewing software application. 

The overall viewing latency comprises:
• Encode latency H.264 encoding is done in the multiviewer device. 

The latency here is approximately 2 video frames.
• Network latency The RTSP streams travel from the multiviewer over a network to 

a destination PC. The latency here will depend on several 
network factors, including: 
• the speed of the network connection; 
• the number of RTSP streams; and 
• the network quality of service settings.

• Decode latency The RTSP streams are decoded by a software application 
running on a PC for viewing. The latency here will depend on 
the PC performance and the application used. 
Factors affecting the latency include: 
• PC processing power, PC memory size, and any PC hardware 

acceleration;
• the number of streams being decoded; 
• application buffer size and settings; and 
• the efficiency of the application’s decode algorithm.

The overall ‘end-to-end’ viewing latency is:

Encode + Network + Decode

And in practice, the Decode latency dominates and determines the overall latency.

Note: GV Orbit Client to view streams: 
GV Orbit Client can be used to view the streams. 
The user can select how much buffering is used, whether to use any 
hardware acceleration for video decoding, and what decoded picture quality 
to use.
These settings are available from the main menu, see the’ Tools > Options > 
Video’ menu item in a GV Orbit multiviewer project:
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Audio Meters
A multiviewer video wall is defined by the GV Orbit multiviewer project running on the 
multiviewer. Typically, this has video tiles which display audio levels via graphical ‘Audio 
Bars’ widgets. 

Audio Meter Type
The ‘Audio Bars’ meter type is defined in one place in the GV Orbit multiviewer project.

In GV Orbit Client with a multiviewer project open and in ‘Design Mode’, to set up the audio 
meter type:

1 Click on ‘Multiviewer > Input Audio’ in the main menu. 

The ‘Input Audio’ dialog is shown.

Fig. 5-1: Input Audio Dialog, Meter Tab

2 Select the ‘Meter’ tab and select the required meter type.
3 Click OK.

This sets the audio meter type globally for the multiviewer project. It also sets the meter 
ballistics for all audio meters.

Audio Meter Ballistics
The multiviewer has one audio meter ballistics setting and this is set by the Audio Meter 
Type setting. All audio data in the multiviewer will have this ballistics.
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CAUTION Audio Meter Ballistics:
All audio data in a multiviewer will have the same ballistics. 
(As set by the Audio Meter Type setting in a GV Orbit multiviewer 
project.)

A video wall can be designed and may use graphical Audio Bars widgets 
to display audio data. The widget’s audio meter type can be changed 
locally on the wall on a video tile, but this only affects that widget’s 
Audio Bars scale. It does not change the audio data ballistics.
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TSL Support

TSL Protocol Tally Settings
TSL protocols are used widely throughout the industry for communication between a TSL 
Tally controller and Under Monitor Displays (UMDs). The protocol enables tally lamp control 
and text label data to be carried to each UMD device.

A TSL Tally controller handles the tally data in a video system and provides TSL Tally control 
information to each UMD.The MV-8 Series Multiviewer supports two TSL protocols: TSL 3.1 
and TSL 5.0. Initial TSL support settings are described here.

Setting up the multiviewer to work with a TSL tally-based system involves the following 
steps:

• Specify how the multiviewer gets the TSL Tally message information.
 See Step 1: Specifying Multiviewer TSL Tally Mode, on page 96.

• Specify index parameters for each UMD on the video wall.
 See Step 2: Specifying Index Parameters for each UMD in GV Orbit, on page 97.

Step 1: Specifying Multiviewer TSL Tally Mode
The multiviewer may get its TSL Tally information in one of two modes:

a) Server Mode - MV-8 Series Multiviewer listens for Tally messages.
Specify the MV-8X0/8X1/8X5 Multiviewer IP address and network port to receive 
Tally messages on.

b) Client Mode - MV-8 Series Multiviewer reads Tally messages from a Tally controller.
Specify the IP address and network port number of the Tally controller.
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The Grass Valley RollCall Control Panel application is used to configure the settings for a 
MV-8 Series Multiviewer in the RollCall TSL control screen; see TSL Control Screen, on 
page 35.

Step 2: Specifying Index Parameters for each UMD in GV Orbit
Use the GV Orbit Client application to set the properties of each UMD in a video tile on the 
video wall layout. The properties differ between TSL Protocol 3.1 and 5.0.

The style of the UMD widget can be selected with the Preferences > UMD Style property.

The index parameters used by each UMD are specifiable in the UMD properties. Values can 
be set manually or values can be automatically assigned as part of assigning inputs to video 
tiles. (Refer to GV Orbit documentation.)

GV Orbit UMD Properties - TSL Protocol Version 3.1
TSL Protocol 3.1 is the original TSL protocol for sending data over a serial comms 
connection or via Ethernet. The multiviewer supports an Ethernet connection. Each 
multiviewer monitor screen is addressed with a Display address. Each UMD widget is 
associated with a video tile in GV Orbit and must have its 3.1 Display Address property set 
up.

Fig. 5-2: TSL Protocol Operating Modes:  a) Server Mode;  b) Client Mode.

a) Server Mode

b) Client Mode
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GV Orbit UMD Properties - TSL Protocol Version 5.0
TSL Protocol 5.0 is a 16-bit protocol, introduced to handle multiviewer display devices over 
Ethernet. It supports ASCII or Unicode character sets, and data is sent as UDP or TCP/IP over 
Ethernet. 

Fig. 5-3:  GV Orbit Video Tile - UMD Widget TSL 3.1 Properties

1. Select Video Tile and the video tile properties are shown.

2. Set Preferences > UMD to ‘True’ and UMD properties are shown below. 
(Expand this property item if required.)

3. Set UMD > UMD Protocol to ‘Version 3.1’ 
and UMD > 3.1 Display Address property is 
shown.
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Each multiviewer monitor screen is addressed by a Screen Index and each UMD within it by 
a Display Index. Each UMD widget associated with a video tile must have two parameters 
set up:

• 5.0 Screen Index - Index number (address) of each display monitor.
(16-bit, $FFFF reserved. 0 = not used.)

• 5.0 Display Index - Index number for each UMD in a display.
(16-bit, $FFFF reserved. 0-based.)

Fig. 5-4:  GV Orbit Video Tile - UMD Widget TSL 5.0 Properties

UMD enabled

TSL 5.0 properties

Selected Video Tile, Multiviewer Input 9

TSL 5.0 selected
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Step 2: Specifying Index Parameters for each UMD in GV Orbit
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High Dynamic Range Video Support
The HDR support at MV-8 Series Multiviewer inputs and outputs is described in this 
section.

Introduction 
An MV-8 Series multiviewer operates with standard dynamic range (SDR) signals internally 
and supports HDR at its video inputs and head display outputs. 

Each multiviewer input supports HDR video input signals: Each input has a dynamic range 
converter which operates on the 10-bit luminance/chrominance values of the input video 
signal and converts from HDR to internal SDR values. The video signal is then re-sized and 
displayed by the multiviewer core etc.

Each multiviewer head display output supports HDR video output signals: Each output has 
a dynamic range converter which operates on the 10-bit luminance/chrominance values of 
the head display output video signal and converts from internal SDR to HDR values. 

Dynamic Range Conversions
Dynamic range conversions use a look-up table (LUT) approach to convert the internal SDR 
to/from the following HDR standards:

• Hybrid-Log-Gamma (HLG).
• Perceptual Quantizer (PQ), SMPTE ST2084.
• Sony Slog3.

As part of the HDR to/from SDR conversions, a user-controlled setting (Nits) determines 
either a) how much of the extra dynamic range in an HDR input signal is used in a 
corresponding internal SDR signal; or b) how much of the extra dynamic range in an HDR 
output signal is used for showing the (SDR) multiviewer head display output image.

Additionally, the processing can use the BT.709 color space (as used in SDR) or convert to/
from the BT.2020 color space (typically used in HDR).

Note: For information about high dynamic range video, refer to the 
‘HDR - A Guide to High Dynamic Range Operation for Live 
Broadcast Applications’ white paper on the Grass Valley web 
site (search on ‘HDR’).

Note: The HDR conversions available on each input and output of the MV-
8 Series multiviewer efficiently handle video images with an 
increased luminance range., enabling a multiviewer to operate in a 
mixed SDR and HDR environment. 

Note: Use specialist test and measuring equipment to analyze and 
monitor the dynamic range, color gamut and color primaries of a 
source video signal.
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Fig. 5-5: Multiviewer Video Input HDR to SDR Processing

Control Settings
HDR processing on each multiviewer video input or output is set up in the multiviewer’s 
RollCall template (control screen). See HDR Setup Control Screen, on page 44.

Nits
The Nits control sets how much of the extra dynamic range of an HDR input signal is used 
when it is converted to SDR internally for the MV-8 Series Multiviewer. And vice versa for 
the HDR conversion at the head display outputs.

• The nominal Nits value is 100 nits for a normal SDR monitor image.
• For the multiviewer video input HDR conversion:

• Video values outside the Nits range are clipped to their limit in the RGB color 
space.

• setting the Nits to a higher value results in a darker picture, which may be useful 
for a brighter monitor. 

Note: Video Input Alarms:
The MV-8 Series Multiviewer contains various input alarms 
(configured with GV Orbit) which look at the video input. For a 
‘video black’ alarm and an HDR input, for example, a ‘video black’ 
detector looks directly at the HDR video input data values (and not 
at any processed, SDR values). 
All alarm configuration settings must be set accordingly.
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The integrated media biometrics support at multiviewer inputs is described in this 
section.

Each multiviewer input supports media biometrics with a media biometrics generator 
(MBG), which produces a low data-rate signature for the respective input video and audio. 
Up to 48 signatures can be generated.

Setting up of an MV-8 Series Multiviewer is done via the multiviewer unit’s control screen 
(RollCall template), see Biometrics Setup Control Screen, on page 42. Multiviewer inputs 
can have media biometrics generation enabled on a per input basis. Audio channels on 
each input can be individually selected for biometric signature generation. Each input’s 
MBG can be individually named for subsequent easier signature identification.

Signature data for all enabled multiviewer inputs is transmitted onto a selected RollCall 
domain via a ‘control’ Ethernet interface of the MV-8X0/8X1/8X5 Multiviewer unit. The 
signature data is compatible with Grass Valley’s SigMA media assurance solution and 
includes a NTP timestamp.

Fig. 5-6: Multiviewer Media Biometric Generators (MBGs)

Note: For information about media biometrics, refer to the 
‘Media Biometrics - Analysis, Detection & Reporting Solution for 
Media Workflows’ data sheet on the Grass Valley web site 
(search on ‘media biometrics’).
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Extended Data Services Support
The extended data services (XDS) support in the MV-8 Series Multiviewer is described in 
this section. 

The MV-8 Series Multiviewer provides access to some of the XDS data on each of its 
video inputs. 

XDS data is extracted from each input and is available externally via RollCall commands. 
Additionally, the data is available internally and XDS data can be used or displayed by the 
multiviewer’s video wall(s).

XDS Data and RollCall Commands
Details of the XDS data types supported and the RollCall command numbers used are 
found in XDS Data Types Supported, on page 183.

On-Screen Example 
This example shows how to access some XDS data on a video input and then display it on a 
multiviewer video wall. This is done by editing the GV Orbit multiviewer project and cause 
it to read various RollCall commands. 

(The complete list of RollCall commands numbers to access XDS data types is in appendix 
XDS Data Types Supported, on page 183.)

Assumptions
• An MV-8X0/8X1/8X5 Multiviewer is running with a known GV Orbit multiviewer project 

in a house system.
• Multiviewer video input 1 carries XDS data.

Procedure
To display XDS data on the video wall:

1 Open the GV Orbit multiviewer project.
2 Create a new empty tile.
3 Add two Label widgets.

Note: For full information about all extended data services, refer to the 
CEA-608-B specification.
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Fig. 5-7: ‘XDS Labels’ on New Tile

4 Select one Label and click the Edit Behaviours icon (see Figure 5-7) to open the 
‘Behaviours and Bindings’ graphical editor.

5 Add a RollCall+ Command Behaviour to the editor. See Figure 5-8.

Fig. 5-8: Add a RollCall+ Command Behaviour

Edit Behaviours icon

Behaviours and Bindings graphical editor

Added RollCall+ Command Behaviour

Direct Binding added automatically
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6 Double-click on the added RollCall+ Behaviour in the graphical editor to edit the 
Behaviour properties.

7 Set the Command Number property to ‘1600’ . 
(This is the V Chip Label, see to Appendix B XDS Data Types Supported, Program Name 
(Title) (V Chip Label), on page 184.)

Fig. 5-9: Edit Behaviour Properties - Command Number

8 Click Close.
9 Repeat for the other Label, but set its Command Number to ‘1650’ . 

(This is the V Chip Rating, see to Appendix B XDS Data Types Supported, Content 
Advisory (V Chip Rating), on page 184.)

10 Click Close.

This has set up access to XDS ‘Program Name’ (V Chip Label) and XDS ‘Content Advisory’ (V 
Chip Rating) data values from multiviewer input 1 and set up two on-screen Label widgets 
for on-screen display of the values.

For clarity in this example: 
11 Further comments may be added onto the tile using labels, as shown in Figure 5-10.

Fig. 5-10: Comment Labels Added to the Tile

12 Click Save in the main tool bar to save the tile changes.
13 Close the tile tab.
14 Open a Wall and drag on the new tile. See Figure 5-11.
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Fig. 5-11: XDS Labels Tile on Wall

15 Click Save. 
16 Click Save Project.
17 Click the Push icon in the main tool bar to push the project to the MV-8XX.

The multiviewer unit deploys the project and the XDS data on video input 1 is shown on-
screen. See Figure 5-12.
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Fig. 5-12: Deployed XDS Labels Tile
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Output Embedded Audio Support
The MV-8 Series Multiviewer supports embedded audio on its head display outputs.

GV Orbit and Output Embedded Audio
The output embedded audio channels are configured in GV Orbit; stereo audio pairs from 
any multiviewer video input can be selected for each output:

1 Open an GV Orbit multiviewer project.
2 Click on Multiviewer > Output Audio in the main menu bar.

The Output Audio dialog is shown, see Figure 5-13.

Fig. 5-13: Output Audio Dialog

3 Set up the audio stereo pair channels for embedding into each multiviewer head 
display output. See Table 5-1.
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4 When all embedded output audio stereo pairs are configured, click OK.
5 Click Save Project.
6 Push the project to the multiviewer unit for the output audio settings to take effect.

 Table 5-1:   Output Audio Dialog Settings  

Setting Description

Select Output To select which multiviewer head display output to 
configure, 
click on an output name in the list (Output 1 to Output 12).

Stereo Output 1 to 
 Stereo Output 8

For each audio stereo pair (1 to 8), select the following:

Input Source Drop-down box.
Select the multiviewer video input (Input 1 to Input 48) 
required to source the audio for the selected output.

Pair Number Drop-down box.
Select which audio stereo pair to use from the input source.
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Input Audio Loudness
There are 48 audio loudness engines in an MV-8 Series core multiviewer. Audio loudness is a 
measure of subjective programme loudness. Loudness is measured in loudness units (LU) 
and are displayed relative to some maximum, full-scale amplitude (units LUFS).

Setting up Audio Loudness requires modifying a GV Orbit project for the multiviewer:
1 pull a GV Orbit from a multiviewer;
2 set up the multiviewer audio loudness engines (see Audio Loudness Engine Setup, on 

page 111);
3 add graphical audio loudness widgets to the video wall and configure them (see Audio 

Loudness Widget, on page 112); and then
4 push the modified video wall design to the multiviewer.

Audio Loudness Engine Setup
There are 48 audio loudness engines per MV-8 Series core multiviewer. In the multiviewer 
project:

1 Select ‘Multiviewer > Input Audio’ in the main menu.
2 Select the Loudness tab.

Fig. 5-14: Input Audio Dialog - Loudness Tab

For each engine:
3 Associate a ‘loudness engine’ with a multiviewer input by selecting an Engine and an 

Input.
4 Select the input audio channels to be processed. Select from the 32 audio channels of 

the associated input. Audio Channel Selection options:
• x - Audio channel is not used.
• F - Audio channel is used and treated as a ‘Front-speaker’ type audio channel.
• S - Audio channel is used and treated as a ‘Surround-speaker’ type audio channel.
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• L - Audio channel is used and treated as a ‘Low frequency (sub)’ type audio 
channel.

Repeat for each engine being configured.
5 Click OK when all done.

An engine’s output can be shown on an Audio Loudness widget on a video wall.

Audio Loudness Widget
In this example, an Audio Loudness widget is added to a video tile.

With a GV Orbit multiviewer project open in GV Orbit Client in ‘Design’ mode:
1 Open a video tile of a video wall.
2 Drag an Audio Loudness widget onto the video tile. See Figure 5-18.

Fig. 5-15: Drag on an Audio Loudness Widget

3 With the widget still selected, click the Edit Behaviours icon.

Drag Audio Loudness widget onto tile

Edit Behaviours iconRun/Design mode icon
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Fig. 5-16: Add an Audio Loudness Behaviour and Binding

4 Click on a Audio Loudness Behaviour.

An Audio Loudness Behaviour and a Binding to the widget.
5 Double-click on the added Behaviour and set up the multiviewer input number, Input. 

This is the input number of the audio to be measured.
6 Click Close.
7 Double-click on the added Binding and set up the audio loudness engine number, 

Engine.
8 Click Close.
9 Click Project > Save File in the main menu to save the tile.

Save and Push
Save the project and push to the multiviewer. The audio loudness widgets should show the 
loudness measurement.

Edit Behaviours icon

Click on an Audio Loudness Behaviour to add an Audio Loudness Behaviour and Binding to the widget.
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Input Audio Phase
There are 48 audio phase engines in an MV-8 Series core multiviewer. Audio phase is a 
measure of the similarity of an audio left-right stereo channel pair. It can to check for 
inversion of an audio channel. An audio phase engine has a response time of approximately 
one second.

Setting up Audio Phase requires modifying a GV Orbit project for the multiviewer:
1 pull a GV Orbit from a multiviewer;
2 set up the multiviewer audio phase engines (see Audio Phase Engine Setup, on 

page 114);
3 add graphical audio phase widgets to the video wall and configure them (see Audio 

Phase Widget, on page 115); and then
4 push the modified video wall design to the multiviewer.

Audio Phase Engine Setup
There are 48 audio phase engines. In the multiviewer project:

1 Select ‘Multiviewer > Input Audio’ in the main menu.
2 Select the Phase tab.

Fig. 5-17: Input Audio Dialog - Phase Tab

For each engine:
3 Associate a ‘phase engine’ with a multiviewer input by selecting an Engine and an 

Input.
4 Select the input audio pair to be phase-compared. Audio Pair Selection options:

• Disabled - Audio Phase engine is disabled.
• Stereo Pair 1 - First stereo pair on the 32-channel input audio.
• Stereo Pair 2.
• ...
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• Stereo Pair 16.

Repeat for each engine being configured.
5 Click OK when all done.

An engine’s output can be shown on an Audio Phase widget on a video wall.

Audio Phase Widget
In this example, an Audio Phase widget is added to a video tile.

With a GV Orbit multiviewer project open in GV Orbit Client in ‘Design’ mode:
1 Open a video tile of a video wall.
2 Drag an Audio Phase widget onto the video tile. See Figure 5-18.

Fig. 5-18: Drag on an Audio Phase Widget

3 With the widget still selected, click the Edit Behaviours icon.

Drag Audio Phase widget onto tile

Edit Behaviours iconRun/Design mode icon
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Fig. 5-19: Add an Audio Phase Behaviour and Binding

4 Click on a Audio Phase Behaviour.

An Audio Phase Behaviour and a Binding to the widget.
5 Double-click on the added Behaviour and set up the multiviewer input number, Input. 

This is the input number of the audio pair to be phase-measured.
6 Click Close.
7 Double-click on the added Binding and set up the audio phase engine number, Engine 

Index.
8 Click Close.
9 Click Project > Save File in the main menu to save the tile.

Save and Push
Save the project and push to the multiviewer. The audio phase widgets should show the 
phase of an audio pair:

Edit Behaviours icon

Click on an Audio Phase Behaviour to add an Audio Phase Behaviour and Binding to the widget.
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• Full green - the pair is in-phase. 
• Full red - the pair is in anti-phase (180 degrees).
• If an audio input is missing the meter will display a small yellow line in the center of the 

widget.
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Core MV Getting Started
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Default IP Addresses .............................................................................................. page 120
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The Core MV Start-up Head Display Splash Screen .................................................. page 122
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This chapter describes getting started with your MV-8X0/8X1/8X5 Multiviewer product 
containing a core MV-8 Series Multiviewer, including the multiviewer start-up splash screen 
and configuring initial basic settings. 
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MV-8 Series Multiviewer configuration is typically performed once after installation of the 
product and is done using Grass Valley’s GV Orbit Client tool.

Following an initial configuration step (see Step 1: Prepare Client Computer, on page 123), 
the multiviewer’s control screens (RollCall templates) may then be used to further configure 
and control various operational multiviewer items, including:

• selection of video wall layouts; 
• monitoring alarm status; 
• acknowledging alarms; and
• control of timer widgets on the video wall.

This section describes how to get started with an MV-8 Series Multiviewer. These 
instructions are applicable to all MV-8 Series Multiviewer devices.

Default IP Addresses
Typically, a new MV-8X0/8X1/8X5 Multiviewer product will be using default IP addresses on 
Ethernet interfaces, which includes one or more ‘control and monitoring’ interface. 

Hardware Installation

Booting Up
A core MV-8 Series Multiviewer within a MV-8X0/8X1/8X5 Multiviewer product shows a 
splash screen on its head display outputs while booting (starting up).

The MV-8 Series Multiviewer boots up after power is applied to the MV-8XX product unit or 
after a system reset (for example, a system reset instigated from RollCall Control Panel). 

Note: GV Orbit Client:

GV Orbit Client is part of the GV Orbit configuration, control and 
monitoring system. The client tool may be run without the full GV 
Orbit system present and, in this case, the tool is termed ‘GV Orbit 
Lite’ and does not have access to the facilities of a GV Orbit 
system, but it can be used to view device control screens and to 
define MV-8 Series Multiviewer video walls on single MV-8 
multiviewer devices.

Note: See the corresponding MV-8X0/8X1/8X5 Multiviewer product 
user manual for Ethernet interface descriptions and default IP 
addresses.

Note: Refer to the corresponding MV-8X0/8X1/8X5 Multiviewer user 
manual for details about unpacking the product, the unit’s rear 
connections and hardware installation.
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Booting takes about 1 to 2 minutes to complete. Approximately 1 minute after starting to 
boot up, each of the multiviewer’s head display outputs presents a gray start-up splash 
screen, see Figure 6-1.

When the MV-8 Series Multiviewer has finished starting up, the start-up splash screen goes 
away (and the green CPU Heartbeat LED on the front main module begins to flash). The 
multiviewer has booted up and the head display outputs then show multiviewer video 
walls belonging to the GV Orbit (or Orbit) multiviewer project being used by the 
multiviewer.

Note: Initially, the first few lines of text appear, followed by the 
remaining lines of text.

Fig. 6-1: MV-8 Series Multiviewer Gray Start-up Head Display Output Splash Screen (Example)

 Table 6-1:   Module Boot-up Time

Operation Duration

Multiviewer Boot-up Up to 2 minutes

Note: If the MV-8XX product’s front main module does not have a flashing “CPU Heart-
beat” LED when it has finished booting, contact Grass Valley Support. 
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.

e)
The Core MV Start-up Head Display Splash Screen
The start-up splash screen on the multiviewer Head Display Outputs shows some MV-8 
Series Multiviewer and MV-8XX product information about the multiviewer unit, see 
Figure 6-2.

Fig. 6-2: Example Start-up Splash Screen Information 

Note: Use the ‘1G1’ multiviewer network interface when performing the 
initial unit configuration with Grass Valley RollCall Control Panel.

Note: The ‘Eng’ interface is a reserved internal IP network interface, do not 
use this IP address.

(2) Software version

(4) Firmware version

(5) Display output showing the splash screen

(3) FPGA number supplying splash screen (Engineering us

(1) Multiviewer core serial number 
Note: The Unit Serial Number is different and is found on a label on the rear of the unit.

(11) RollCall+ Domain number (12) Unit’s RollCall+ address

(6) Multiviewer Control 
Network Interfaces

(7) (8) (9) (10)

(7) IP Address

(8) Sub-net Mask

(9) Network link status:

• up - network link working

• down - network link not working

• invalid - no network SFP fitted

(10) IP Address type:

• static

• DHCP
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Step 1: Prepare Client Computer
Items required:

• A laptop, or some computer, with an RJ45 Ethernet port and with Grass Valley GV Orbit 
Client installed.

• A ‘CAT 5 Ethernet cable. 

Initial connection to the core multiviewer of an MV-8 series multiviewer device should be 
carried out on a separate IT network, separate from any house IT network. Initial 
configuration sets up device IP addresses and communication settings.

Fig. 6-3: Initial Configuration, separate from House System

To prepare a computer for initial connection:
1 Select which computer Ethernet RJ45 port to use 

and set the port to a fixed IP address on the same network sub-net as the MV-8 Series 
Multiviewer. 

(For example, use 10.54.31.200 for the computer port when connecting to a 
multiviewer default IP address of 10.54.31.221. 
Note: Multiviewer default IP addresses are listed in the ‘Specification’ appendix of each 
MV-8X0/8X1/8X5 Multiviewer product user manual.) 

2 Disable any WiFi connections on the computer. (Because these may interfere with the 
wired RJ45 port.)

3 Directly connect the computer RJ45 port to the chosen multiviewer control Ethernet 
port of the MV-8X0/8X1/8X5 Multiviewer product using the Ethernet cable. (A ‘cross-
over’ cable may be required.)

Note: Default IP Address on Ethernet control interface:

Typically, a new MV-8X0/8X1/8X5 Multiviewer product has two 
multiviewer Ethernet control interfaces and will be using a 
default IP address, detailed in the respective MV-8X0/8X1/8X5 
Multiviewer product user manual.

MV-8 Series 
Multiviewer
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Step 2: GV Orbit Client Connection
When connecting for the initial device configuration, the computer should be connected 
directly to the multiviewer. If connecting after an initial device IP address has been set up 
(e.g. for further unit configuration), then connect with your house system network.

To connect GV Orbit Client to the MV-8 Series Multiviewer:
1 With the computer connected to the 1G Ethernet port of the MV-8X0/8X1/8X5 

Multiviewer, open the GV Orbit Client application.

The application starts and the initial screen is displayed.

Fig. 6-4: GV Orbit Client Initial Screen

Note: Refer to the corresponding product user manual for the MV-8X0/
8X1/8X5 Multiviewer product for details of rear panel Ethernet 
connections.

Control Screen icon
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2 Click on the Control Screen icon. 

The Open Template dialog is shown.
3 Enter the IP address of the multiviewer 

device. 
Click OK to connect to the device.

The control screen for the MV-8 Series multiviewer core is shown in the main pane of 
the GV Orbit Client tool. 
GV Orbit Client has now connected to the multiviewer unit.

The control screen comprises several pages. Figure 6-5 shows the first page of the control 
screens. Other pages are accessed via the highlighted Selection Box in the banner of the 
page. See Core MV Control Screens, on page 11, for a full description of the control screens.

Note: Default IP addresses for the network interface ports are detailed in the 
respective MV-8X0/8X1/8X5 Multiviewer user manual.

Note: The IP addresses of multiviewer ‘control’ Ethernet interfaces (used 
during initial multiviewer configuration) can be found by:

• Enabling the Output Overlay feature on head display 
outputs (see Layout Control Screen, on page 31, and 
Overlays, on page 33) to show IP address information briefly 
on the outputs.

Or
• Restart the multiviewer product by re-applying power, 

causing a MV-8 Series Multiviewer reboot. IP address 
information is shown in the monitor splash screen, 
Booting and Splash Screen, on page 9 and its Figure 2-1 on 
page 10.
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Fig. 6-5: MV-8 Series Multiviewer Control Screens 

 

For initial configuration settings of the multiviewer unit, continue to Step 3: Initial 
Multiviewer Unit Settings, on page 127.

Selection Box
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Step 3: Initial Multiviewer Unit Settings
(Initial configuration should be carried out on a separate IT network, separate from any 
house IT network.) 

This initial configuration sets up an MV-8X0/8X1/8X5 Multiviewer unit’s IP addresses and 
communication settings:

1 Select the System-Setup control screen in the upper Selection Box of the control 
screen. 

In the System-Setup control screen: 
2 Under Network Setting, set up the Ethernet interface IP network settings relevant to 

your house network.
3 Under RollCall Settings, set up:

• Unit number (must be unique for each unit); and
• Domain ID the GV Orbit GVOP Domain number to use (typically the same for each 

unit).
4 Under Output Format, select the video format and frame rate for all the multiviewer’s 

head display outputs (for example, ‘1080p50’, or ‘720p59’).
5 Under Reference Input, select the video reference input for the core multiviewer to 

use (for example, ‘input A’, or ‘free run’).

Once all setting changes in the System-Setup control screen have been done:
6 Click on the System Reset button at the top of the System-Setup control screen 

(see System Box, on page 14, and System Reset to Implement Settings Changes, on 
page 24).
Then click Confirm to perform a system reset. 

When the multiviewer unit has re-booted, the new settings will be adopted. The 
multiviewer can then be connected to your house IT network.

IMPORTANT 
A System Reset of the multiviewer is required before saved 
settings changes in the System-Setup control screen take effect.

Such a reset will affect all MV-8X0/8X1/8X5 Multiviewer 
connections, including the multiviewer head display outputs. 
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Step 4: Connecting into House System

Fig. 6-6: Multiviewer Connected to House System

After setting up the initial settings, the MV-8X0/8X1/8X5 Multiviewer unit can then be 
connected to your house system, including IT network connections and video input/output 
connections. 

Refer to the corresponding MV-8X0/8X1/8X5 Multiviewer user manual for details about unit 
connections and connecting up the unit.

Further configuration can be done via the multiviewer’s control screens (RollCall 
templates), as required. Control screens for the MV-8 Series Multiviewer are describe in Core 
MV Control Screens, on page 11.

Default Video Wall

By default, after booting up, a new MV-8 Series Multiviewer will display each of the 48 
multiviewer video inputs on a default video wall layout. This done on four multiviewer head 
display outputs (Outputs 1 to 4), see Figure 6-7.

IMPORTANT Ethernet connection:
Check the logical and physical connection of all ‘control and monitoring’ 
Ethernet ports on the MV-8X0/8X1/8X5 Multiviewer product’s rear panel. 
This is required for optimum MV-8 Series Multiviewer performance. 

Explanation:

An MV-8X0/8X1/8X5 Multiviewer product typically has more than one 
control Ethernet port - for example “1G1” and “1G2”. 
However, if a port is disconnected, its IP address can still be “seen” 
through the other port. This means the MV-8 Series Multiviewer can 
still appear to be operating normally even with one or more 
unconnected control network ports. But there is a performance 
penalty for operating with such an unconnected network port.

MV-8 Series 
Multiviewer

House System
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Fig. 6-7: MV-8 Series Multiviewer Default Video Wall on Multiviewer Head Display Outputs 1 to 4 

Identifying Display Outputs and Video Inputs
To help with getting started and with unit system set up, the multiviewer can be configured 
to identify its inputs and outputs with an overlay on each multiviewer head display output. 
It can do this regardless of whether a video input is being supplied. 

1 View the Layout control screen. (See Layout Control Screen, on page 31.)
2 Use the controls to turn on/off the display of overlay information to identify:

• multiviewer inputs; and/or 
• head display outputs. 

See Figure 6-8.

V-8 Series Multiviewer

Video inputs 1 to 48 are shown

Fig. 6-8: Layout Control Screen - Multiviewer Display Output Overlays
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Step 5: Further Unit Configuration
Further settings changes can be done at any time with GV Orbit Client either via the control 
screens or via the GV Orbit multiviewer project. 

• Settings changes done in the System-Setup control screen will need a System Reset. 
See Settings Changes and System Reset, on page 15. 

• Changes to the multiviewer project will require the project being pulled from the 
multiviewer, edited and pushed back.

Setting up Input Alarms and Unit Alarms
Alarms on an MV-8 Series Multiviewer are defined in the GV Orbit multiviewer project, in 
the ‘Multiviewer’ main menu item. See Core MV Input Alarms, on page 51, for a description 
of the GV Orbit settings and see Getting Started with GV Orbit, on page 131, for an 
introduction to setting up alarms.

Setting up TSL Support
See TSL Support, on page 96.

CAUTION 
Some System-Setup control screen changes may affect the MV-8X0/8X1/
8X5 Multiviewer unit’s outputs and network operation.

IMPORTANT 
A System Reset of the multiviewer is required after settings changes in 
the RollCall System-Setup control screen.

Such a reset will affect all MV-8X0/8X1/8X5 Multiviewer product’s 
connections, including the multiviewer outputs. See Settings Changes 
and System Reset, on page 15.

When the MV-8X0/8X1/8X5 Multiviewer has re-booted, the new settings 
will be adopted.

Note: Configuring IP Inputs:
• MV-820-IP: To configure the IP inputs of an MV-820-IP, 

refer to the MV-820 Multiviewer user manual. 
Specific IP input configuration instructions are found in the 
‘Getting Started’ chapter.

• MV-821-IP: To configure the IP inputs of an MV-821-IP, 
refer to the MV-821 Multiviewer user manual. 
Specific IP input configuration instructions are found in the 
‘Getting Started’ chapter.
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Getting Started with GV Orbit
Introduction ....................................................................................................................... page 132
Get Multiviewer Project from a Multiviewer Unit ...................................................... page 133

Save Project ............................................................................................................. page 137
Edit a Project Name ............................................................................................... page 137

Set Up Input Alarms ......................................................................................................... page 139
Select One Input to Configure ............................................................................. page 139
Set up Video Lost Alarm ....................................................................................... page 140
Set Up Audio Levels Alarm ................................................................................... page 140
Copy Input Alarm Settings ................................................................................... page 143

Set Up Multiviewer Unit Alarms .................................................................................... page 144
Set Up Multiviewer Input Audio .................................................................................... page 146

Audio Meter Type ................................................................................................... page 146
Audio Reference ..................................................................................................... page 147
Audio Loudness ...................................................................................................... page 147
Audio Phase ............................................................................................................ page 148
Finally ....................................................................................................................... page 148

Set Up Multiviewer Output Audio ................................................................................. page 149
Quick Edit of Video Wall .................................................................................................. page 150
Push a Project to a Multiviewer Device ....................................................................... page 156
On-Screen Alarm Warnings ........................................................................................... page 158
Pull a Project from a Multiviewer Unit ......................................................................... page 159

This chapter describes getting started with the multiviewer and a GV Orbit multiviewer 
project with GV Orbit Client. A video wall design is got from a multiviewer, alarm settings 
are described and simple video wall edits are carried out. The project is then pushed back 
to the multiviewer device.
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After the MV-8 Series Multiviewer unit is configured and ready to be added into the house 
network (see Core MV Getting Started, on page 119), the default GV Orbit multiviewer 
project may be pulled from the unit, modified and pushed back to the unit. 

This section will:
• Get the GV Orbit multiviewer project from the MV-8 Series multiviewer unit 

(i.e. the default MV-8 Series Multiviewer GV Orbit project for a new, factory unit).
• Set up multiviewer alarms in the project.
• Make a simple, visible changes to the video wall.
• Push the amended project back to the unit.

And finally, it describes how to:
• Pull a project from a MV-8 Series multiviewer unit.

This section assumes that:
• The MV-8X0/8X1/8X5 Multiviewer is running and is connected to a control Ethernet 

network.
• IP addresses of the MV-8X0/8X1/8X5 Multiviewer Ethernet interfaces are known.
• GV Orbit Client is installed on a client computer also connected to the control network. 

(Note: Access to a GV Orbit system is not required for basic GV Orbit Client multiviewer 
operation.)
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The first time that a GV Orbit Client connects to a multiviewer, the client PC will not have a 
local copy of the multiviewer’s GV Orbit multiviewer project. In this case, a local project 
needs to be created from the existing multiviewer. For subsequent edits to that 
multiviewer, the project on the multiviewer may simply be pulled from the unit into the 
local copy of the project on the client PC for editing in GV Orbit Client.

Pulling a project is described in Pull a Project from a Multiviewer Unit, on page 159. 

Here, we describe a first time connection and will create a new project from an existing MV-
8X0/8X1/8X5 Multiviewer unit:

1 Run GV Orbit Client and click New Project on the initial screen.

Fig. 7-1: Click New Project

2 Select Connected Multiviewer Project.
3 Click Browse to browse into a new and empty folder, and click Choose.
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Fig. 7-2: New Project Dialog - Connected Multiviewer Project

4 Click Next.

All accessible multiviewer devices are auto-discovered and listed.

Note: Auto-discovery of multiviewer devices relies on GV Orbit ‘GVOP’ 
data packets being present on the network. Ensure these are 
supported by the house network system. Contact Grass Valley 
customer support for further information.
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Fig. 7-3: New Project Dialog - Discovered Multiviewers List

If no devices are discovered automatically, then a device’s IP address and GVOP Domain 
number may be specified manually. 
To specify manually:

5 Click Specify Host and enter the device’s GV Orbit GVOP Domain number and IP 
address.

6 Click Refresh.
7 The specific device should be listed.

Fig. 7-4: New Project Dialog - Specified Multiviewer List

Then:
8 Select a device in the list and click OK.

GV Orbit Client connects to the device and pulls the GV Orbit multiviewer project from 
the device. (For a new multiviewer, this is the default project.)
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9 At the login dialog, enter the appropriate project User Name and Password. 
Note: For a default project on a new, factory unit, this is ‘admin’ and ‘admin’.

Fig. 7-5: Login Dialog

10 Click Login.

The project is opened and shown in GV Orbit Client.

A new GV Orbit project has been created from the connected multiviewer and opened in 
GV Orbit Client.
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Fig. 7-6: Example Project Open in GV Orbit Client

Save Project
To save a project on the local computer in the previously-specified folder:

1 Click Project > Save Project in the main menu,
or click the Save Project icon in the main tool bar.

Edit a Project Name
The GV Orbit Client home screen shows a ‘Project Name’, which is treated as an identifier by 
GV Orbit. The name may be changed with the ‘Edit Name’ control in the home screen.

Projects with the same name are considered to be the same and GV Orbit warns the user if 
there are any differences between a project in GV Orbit and the same-named project on a 
multiviewer device. Such differences must be resolved.

Save Project icon  Local folder path where project is locally stored
Project name

Note: Use a different and unique GV Orbit project name for each multiviewer.
Rename a default project that has been pulled from a multiviewer.
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To edit a project name in GV Orbit Client:
1 Click Edit Name, on the project home 

screen to rename the project.
2 Enter a new project name 

and click OK.

(This will avoid over-writing the default 
project on the multiviewer later.)

3 Click Project > Save Project in the main menu,
or click the Save Project icon in the main tool bar.
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Input alarms can be set up and enabled on each multiviewer input. These are definable in 
the GV Orbit multiviewer project. 

In this ‘Getting Started’ example, a video alarm and an audio alarm are enabled on one 
input and then those input alarm settings are copied to all the inputs. 
(See Core MV Input Alarms, on page 51, for a description of the Input Alarms dialog and its 
tabs.)

With the multiviewer project open in GV Orbit Client:

Select One Input to Configure
1 Click on ‘Multiviewer > Input Alarms’ in the main menu.

The Input Alarms dialog is shown.

Fig. 7-7: Input Alarms Dialog

In the ‘Input’ tab.
2 Select ‘Input 1’ by either:

• selecting ‘Input 1’ in the Input Selection list; or by
• using the drop-down Selected Input list.

The selected input (‘Input 1’) is then shown in the Selected Input box which also 
appears on other tabs too.

Selected Input
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Set up Video Lost Alarm

To enable the ‘Video Input Lost’ alarm:

1 Select the ‘Alarm’ tab.
2 Scroll down the list of alarms in the Select Alarm box and select ‘Video Input Lost’. 
3 In the properties section, select Alarm Enable. See Figure 7-8.

Fig. 7-8: Video Input Lost Alarm Enabled

Set Up Audio Levels Alarm

To enable the ‘Audio Levels’ alarm:

1 Select ‘Audio Level’ in the list of alarms and then in the properties section, select 
Alarm Enable. See Figure 7-9.

CAUTION Selected Input appears on other tabs and it may be 
changed at any time. 
Use caution to avoid inadvertently changing this.

Selected Input is shown
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Fig. 7-9: Audio Levels Alarm Enabled

The Audio Level alarm needs further settings to be configured and this is done in the other 
tabs of the Input Alarms dialog:

2 Select the ‘Levels’ tab.

This shows the various audio levels that the Audio Levels alarm uses.
These can be adjusted if required.

Fig. 7-10: Levels Tab

3 Select the ‘Audio 1-16’ tab and/or the ‘Audio 17-32’ tab.

This shows the audio channels that the various audio alarms monitors. 
Note: Audio alarms that are not enabled are grayed-out in the tab.

These channels can be selected/deselected as required. See Figure 7-11.

Enabled alarms are 
underlined in the 
Select Alarm list.
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Fig. 7-11: Audio Channels 1-16 (17-32)

This has now set up the ‘Video Lost’ alarm and ‘Audio Levels’ alarm for multiviewer Input 1.
142



MV-8 Series Multiviewer
User Manual
Copy Input Alarm Settings
To apply the same to all the other multiviewer inputs:

1 Select the ‘Input’ tab.

Fig. 7-12: Copy Alarm Settings from Input 1 to All Multiviewer Inputs

2 Click Copy All.

The alarm settings of the ‘Selected Input’ (Input 1) are copied to all the other Inputs.
3 Click OK.  
4 Click Project > Save Project. to save the project settings changes.

The Video Input Lost alarm and Audio Levels alarm are enabled on all the multiviewer’s 
48-input multiviewer inputs. 

Selected 
Input List of all inputs 

to copy to. This is 
all the inputs by 
default.
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Set Up Multiviewer Unit Alarms
The unit alarms that can be set up and enabled in the multiviewer project via the 
‘Multiviewer’ main menu item. 

Unit alarms are not related to any one multiviewer input. The configuration dialog is 
accessed in the following way in GV Orbit Client when a multiviewer project is open:

1 Click Multiviewer > Unit Alarms in the main menu.

A Unit Alarms dialog box, Figure 7-13, shows the possible unit alarms, see Table 7-1.

Fig. 7-13: Unit Alarms Dialog

2 Click on an alarm name in the Select Alarm list.

The selected alarm’s properties are shown.
3 Unit alarm properties are described in Table 7-2. Select as required for each alarm.

 Table 7-1:   Unit Alarms

Alarm Description

Genlock State Detects unlocked multiviewer genlock.

Reference Input Lost Detects a lost reference signal.

 Table 7-2:   Unit Alarms Properties  

Alarm Property Description

Alarm Enable Check box. 
Select to enable the alarm.

Delay 
(seconds)

Text box.
The time in seconds from when a fault is detected to when the 
alarm is displayed on the multiviewer video wall. 

Set a small delay to prevent transient alarms being displayed, 
filtering out transient alarms.

Automatic 
Acknowledgment

Check box. 
Select to enable automatic acknowledgment by the multiviewer 
system. 

Deselect to manually acknowledge the alarm. Alarms will have to 
be acknowledged by the user, to stop an alarm flashing.
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4 Click OK.
5 Click Save Project icon in main tool bar.

Delay 
(seconds)

text box.
The time in seconds from when the alarm occurs to when it is 
automatically acknowledged by the multiviewer system. 

Set a delay here to allow an alarm to flash and be displayed for a 
short time before being automatically acknowledged.

Note: Each alarm has its own ‘Alarm Enable’ and ‘Automatic Acknowledge’ 
properties.

 Table 7-2:   Unit Alarms Properties  (continued)

Alarm Property Description
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Set Up Multiviewer Input Audio
Input audio settings are defined in the Input Audio dialog.

Audio Meter Type
A video wall’s audio meter scale type and signal ballistics are set up for the metering in 
Audio Bars graphical widgets in this tab. (See Audio Meters, on page 94 for more 
information.) All audio metering in the multiviewer will use the same setting.

1 Click Multiviewer > Input Audio in the main menu.

The Input Audio dialog box is shown. See Figure 7-14.

Fig. 7-14: Input Audio Dialog - Meter Tab

2 In the Meter tab, select the Meter Type to apply to all audio channels of all multiviewer 
video inputs. 

CAUTION Audio Meter Ballistics:
Audio meter ballistics apply globally per multiviewer.

A GV Orbit multiviewer project user may change an Audio Bars widget 
audio meter type locally on a video wall tile/schematic, which only 
locally changes the meter scale on the tile/schematic. 
IMPORTANT
However, all audio meter data from the same multiviewer will all have the 
same ballistics type, i.e. that of the Meter Type set up in the Multiviewer 
> Input Audio dialog.
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1 Select the Reference tab.

Fig. 7-15: Input Audio Dialog - Reference Tab

2 Select the Digital Audio Reference to apply to all audio channels. 

Audio Loudness
There are 48 audio loudness engines. (See Input Audio Loudness, on page 111, fro more 
information.)

1 Select the Loudness tab.

Fig. 7-16: Input Audio Dialog - Loudness Tab

Internal ‘loudness engine’ selection:
2 Associate a ‘loudness engine’ with a multiviewer input by selecting an Engine and an 

Input.

Audio channel selection and configuration:
3 Select the audio channels to be processed for each engine, where:

• “x” channel not used;
• “F” channel is a ‘Front speaker’ type; 
• “S” channel is a ‘Surround speaker’ type; and 
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• “L” channel is a ‘Low frequency (Sub)’ type.

Repeat for each engine being configured. 
An engine’s output can be shown on an Audio Loudness widget on a video wall.

Audio Phase
There are 48 audio phase engines. (See Input Audio Phase, on page 114.)

1 Select the Phase tab.

Fig. 7-17: Input Audio Dialog - Phase Tab

Internal ‘audio phase engine’ selection:
2 Associate a ‘phase engine’ with a multiviewer input by selecting an Engine and an 

Input.

Audio stereo pair selection:
3 Select the Audio Pair to be phase-compared.

Repeat for each engine being configured. 
An engine’s output can be shown on an Audio Phase widget on a video wall.

Finally
When all the tabs are set up:

1 Click OK in the Input Audio dialog.
2 Click Save Project icon in main tool bar.
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Set Up Multiviewer Output Audio
The Output Audio dialog is used to set up the audio sources for each of the audio channels 
in each of the multiviewer head display outputs. Up to eight stereo channels are embedded 
in each multiviewer head display output. (See Output Embedded Audio Support, on 
page 109, for more information.)

1 Click Multiviewer > Output Audio in the main menu.

The Output Audio dialog box is shown. See Figure 7-18.

Fig. 7-18: Output Audio Dialog

2 In the Select Output list, select an output (‘Output 1’, ‘Output 2’,  ... or ‘Output 12’).

This selects the multiviewer head display output to configure.
3 Select the source audio stereo pairs for the head display output. Up to 8 stereo pairs per 

head display output: For each output pair:
• select the multiviewer input; and
• select input stereo pair.

The selected audio sources are embedded in each multiviewer head display output. 
They can be monitored via a suitable display or audio de-multiplexer.

Repeat for each licensed head display output.

When all the head display outputs are set up:
4 Click OK in the Input Audio dialog.
5 Click Save Project icon in main tool bar.

Note: Dolby E audio on multiviewer inputs cannot be decoded for 
embedding onto the display output for monitoring.
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Quick Edit of Video Wall
To make a quick and visible change to the video wall:

1 Click the large Walls icon and select a wall item in the list, for example, ‘Output 1’. See 
Figure 7-19.

The selected wall is opened in a Wall Editor in GV Orbit Client. See Figure 7-22.

Fig. 7-19: Project Open in GV Orbit
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Fig. 7-20: Example Wall Open in Wall Editor in Run Mode

Figure 7-20 shows the GV Orbit Wall Editor in Run Mode. To perform edits to the 
multiviewer video wall, the Wall Editor must be in Design Mode. 

To change from Run Mode to Design Mode:
2 Click the Design Mode icon in the main menu. (See Figure 7-20.)

GV Orbit enters Design Mode. See Figure 7-21.

Clock and Text Label tile
Design Mode/Run Mode icon (Run Mode shown)
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Fig. 7-21: Example: Wall Editor in Design Mode 

3 Double-click on the Clock and Text Label tile.

The tile is opened in the Tile Editor. See Figure 7-22.

Clock and Text Label tile
Run Mode/Design Mode icon (Design mode shown)

Note: Clicking on the Design Mode/ Run Mode icon toggles between 
modes.
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Fig. 7-22: Tile Editor 

To make a change to the tile:
4 Click on the tile background.
5 In the Properties box, select the ‘Extended Style > Background > Background Color’ 

property.
6 Click on the   ...    icon to show the Background Color color select dialog. See Figure 7-23.
7 Select a color and click OK.

Background Color tile property   ...    icon

Properties box Tile
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Fig. 7-23: Color Picked 

8 Click the Save File icon in the main tool bar to save the tile change.

Fig. 7-24: Tile with New Background Color 

9 Click on the  x  on the Tile tab to close the tile and on the Wall tab to close the wall.
10 Click on the Save Project icon in the main tool bar to save all changes in the project to 

the local PC storage.

Color selected

Alpha 255 (fully 
opaque)

Click to Save File and Click  x  to close tile
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Fig. 7-25: Example Changed Wall

The project is saved on the PC. Once all changes are made, the next step is to push it back to 
the multiviewer.

Click to Save Project

Click  x  to close the Wall
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Push a Project to a Multiviewer Device
To push a project from GV Orbit Client onto a multiviewer device:

1 Open the multiviewer project in GV Orbit Client and click Multiviewer > Properties in 
the main menu.

Some multiviewer details are shown in a Properties dialog. (A GV Orbit multiviewer 
project stores the name etc. of the multiviewer unit that it came from.)

Fig. 7-26: Multiviewer Properties Dialog

2 Check the multiviewer details.
If the multiviewer details are correct, then proceed; 
however, if the details require changing, enter the target device’s:

• IP address;
• RollCall network number and unit number; and 
• Domain ID. 

Click OK.

To push a project to the multiviewer:
3 Click the Push icon in the main menu. See Figure 7-27.

Multiviewer details
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Fig. 7-27: Pull/Push Icons and Choose Projects Dialog

4 Select the project name in the Choose Projects dialog (scroll down the list of possible 
projects as required, the may already be selected). See Figure 7-27. 
and click OK.
The project is then pushed to the multiviewer.

5 When the push is complete a ‘pushed successfully’ message is shown. See Figure 7-28b. 
Click OK.

Fig. 7-28: Push Messages

The project is now running on the target MV-8 Series Multiviewer. The edited tile 
background color is changed.

Pull icon

Push icon Choose Projects Dialog

Project Name

Project Name is selected

Project Name

Note: If the multiviewer already has a project of the same name, then a 
dialog is shown. Click ‘Yes’ to overwrite with the project from GV 
Orbit Client (see Figure 7-28).

a) Push Message b) Push OK.
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On-Screen Alarm Warnings
With the project running on the multiviewer, to provoke a ‘Video Input Lost’ alarm:

1 Disconnect a video signal going to the 48-input multiviewer (for example, to Input 25). 
I.e. disconnect signal at the MV-8 Series Multiviewer’s Video Input connector. 

Video loss is detected at the 48-input multiviewer input.
A slow-flashing, red rectangular border appears around the 
corresponding video wall tile.

Alarms may also be seen in the GV Orbit Client’s Network 
window and in the Alarm Summary window for the 
multiviewer:

2 In the Network window,
locate and expand the MV-8 Series Multiviewer item.

3 Right-click on a sub-item of the multiviewer item (for example, the red Input 25 ‘sub-
item’) and select Alarms in drop-down menu. 

An Alarm Summary window shows the 48-input multiviewer’s Input 25 status. See 
Figure 7-29.

Fig. 7-29: Alarm Showing in:
a) Network Window. 
b) Alarm Summary Window.

a) Network window

b) Alarm Summary window

Right-click, select ‘Alarms’
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Pull a Project from a Multiviewer Unit
To pull a project into GV Orbit Client from a MV-8X0/8X1/8X5 Multiviewer unit:

1 Open a multiviewer project in GV Orbit Client and 
click Multiviewer > Properties in the main menu.

The Multiviewer Properties dialog is shown. 
(This dialog is shown in Figure 7-26 on page 156.)

2 Check that the multiviewer details are correct for the target multiviewer or, if the 
multiviewer details require changing, enter the target device’s:

• IP address;
• RollCall network number and unit number; and 
• Domain ID. 

Click OK.
3 Click the Pull icon in the main menu. 

(The Pull icon is shown in Figure 7-27 on page 157.)

The Choose Projects dialog is shown. (The dialog is shown in Figure 7-27 on page 157.)
4 Select the required project in the Choose Projects dialog (scroll through the project 

list is required).
And click OK.

The project is pulled from the device.
5 When the pull is complete a ‘pulled successfully’ message is shown. Click OK. See 

Figure 7-30. 

Fig. 7-30: Pull Message

The GV Orbit project of the same name in as the one pulled from the device has now been 
updated into GV Orbit Client. The project in GV Orbit Client is now the same as that on the 
multiviewer.
159



Getting Started with GV Orbit
Pull a Project from a Multiviewer Unit
160



Core MV Maintenance 
Core MV Maintenance
Licensing ............................................................................................................................. page 161
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This section describes various software maintenance operations for the MV-8 Series 
Multiviewer. These operations are carried out via the control interface of the MV-8 Series 
Multiviewer. Refer to the respective MV-8X0/8X1/8X5 Multiviewer user manuals for details 
about the control Ethernet interface to use.

Information about an MV-8 Series Multiviewer’s software version, serial number etc. is 
displayed on the RollCall System - Setup control screen.

Licensing
Licenses give access to additional MV-8 Series Multiviewer features:.
For example, for:

• extra head display outputs from an MV-8 Series core multiviewer; or 
• 12G video input capability for an MV-821 unit; or
• 12G video input/output capability for an MV-825-RTR unit.

License Files
The license files for the MV-8 Series Multiviewer are supplied upon purchasing a license 
from Grass Valley. They are small .zip files. 

The license key within the file is tied to the core multiviewer serial number of the MV-8X0/
8X1/8X5 Multiviewer unit, which is shown on the splash screen (and is reported by RollCall). 

Note: MV-821:
For a ‘H.264 stream’ license on MV-821 multiviewers, factory-fitted codec 
modules are specifically required.
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License Installation Procedure
The process of adding a license to an MV-8 Series Multiviewer follows the standard process 
for a hardware module with licenses administered by Grass Valley RollCall. 

For more details, please see the Grass Valley ‘RollCall Control Panel User Manual’ or the 
Grass Valley ‘RollMechanic Operator’s Manual’.

For RollCall Control Panel, MV-8 Series Multiviewer license installation is a two-stage 
process:

• Stage 1: Add License to RollCall Control Panel, on page 162.
• Stage 2: Install License on the MV-8 Series Multiviewer, on page 163.

These are described in the sub-sections below and are applicable to licensing an MV-8 
Series Multiviewer, and an MV-821-IP product’s video IP rears. 

Stage 1: Add License to RollCall Control Panel
The example below uses Grass Valley RollCall Control Panel. See Software Versions, on 
page 181, for the minimum version of RollCall Control Panel to use for the multiviewer 
device being licensed.

1 Run the RollCall Control Panel software.
2 Connect to a MV-8 Series Multiviewer on a MV-8X0/8X1/8X5 Multiviewer product unit. 

(Click the  icon and enter the IP address in the Build Network dialog. Click OK.)

Fig. 8-1: Build Network Dialog in RollCall Control Panel Tool

3 Click the Edit Licenses icon  or click Edit > Licenses.
The License Viewer window is displayed.

4 Click on the Multiviewer Licenses tab.
Available licenses in your RollCall Control Panel tool are listed.

To import your license:
162



MV-8 Series Multiviewer
User Manual
5 Click Import Licenses. 
Navigate to the license zip file and select the license file name. 
Click OK.
The license is imported into RollCall Control Panel and is added to the listed licenses. 
See Figure 8-6.

The license is now added to RollCall Control Panel.

Fig. 8-2: Example License Viewer Dialog (An image for MV-821 is shown)

Stage 2: Install License on the MV-8 Series Multiviewer
Once the required license is imported into RollCall Control Panel, the next stage is to install 
the license on the device (MV-8 Series Multiviewer, or MV-8X0/8X1/8X5 Multiviewer video 
IP block etc.).

1 Right-click on the connected Multiviewer block in the left-hand pane of the RollCall 
Control Panel screen. 
Click Unit License.

List of available imported licenses shown in the tab

Import 
Licenses 
button

Fig. 8-3: Right-Click Menu - Unit License
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Stage 2: Install License on the MV-8 Series Multiviewer
2 The Unit License window shows current licenses and available licenses. See Figure 8-4.

Fig. 8-4: Unit License Dialog - Selected License (An image for MV-821 is shown)

3 Select the available license to be installed. 
4 Click the Install License button.
5 An Install License dialog appears, click Yes to install the license.

The license is installed on the multiviewer and the multiviewer restarts (reboots).
Click OK.

6 Rebooting takes approximately 4 minutes.
While the unit is rebooting, RollCall Control Panel will lose connection with it.

When the multiviewer finishes rebooting, it is operating with the newly-installed license.

Selected 
License
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Software Upgrade Package

A software upgrade package from Grass Valley is supplied by Grass Valley Support and 
comprises a set of data and installer files, typically approximately 500M bytes in size. The 
package is associated with a MV-8 Series Multiviewer software version number, for 
example, 3.1.4, and may contain a software upgrade for one or more devices.

Software Upgrade Procedure
The software upgrading process follows the standard process for module upgrades with 
Grass Valley RollCall Control Panel. For more details, please see the Grass Valley RollCall 
Control Panel User Manual or the Grass Valley RollMechanic Operator’s Manual.

The upgrade process applies to:
• MV-8 Series Multiviewer software; or to
• MV-820-IP video IP rear software; or to
• MV-825-RTR router software.

Upgrading is a two-stage process:
• Stage 1: Add the upgrade package to RollCall Control Panel. 

    See Stage 1: Add Upgrade Package to RollCall on page 165.
• Stage 2: Install the upgrade on the MV-8 Series Multiviewer.

    See Stage 2: Install the Upgrade on the MV-8 Series Multiviewer on page 167.

These are described in the sub-sections below.

Stage 1: Add Upgrade Package to RollCall
This stage is applicable to upgrading MV-8 Series Multiviewer software (or to upgrading an 
MV-821-IP product’s video IP rears, or to upgrading the MV-825-RTR router software). 

The example below uses Grass Valley RollCall Control Panel. See Software Versions, on 
page 181, for the minimum version of RollCall Control Panel to use for the multiviewer 
device being licensed.

1 Run the RollCall Control Panel software.

IMPORTANT 
Before carrying out an MV-8 Series Multiviewer software upgrade, please ask 
Grass Valley support for advice and inform Grass Valley support of the software 
versions you have for:

• MV-8 Series Multiviewer on your MV-8X0/8X1/8X5 Multiviewer product.
• Any other Grass Valley MV-8X0/8X1/8X5 Multiviewers.
• Orbit Client software application.
• GV Orbit Client software application.

Note: MV-8 Series Multiviewer software downgrades may also be carried out 
with the same procedure.
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2 Connect to the multiviewer block as required.
3 Click the Import New Upgrade icon, see Figure 8-5.

The RollCall Upgrade Packages window is displayed.

4 Click the Import Upgrade Package button.
5 Navigate into the folder containing the upgrade package.

Click on the .zip file name (see Figure 8-6).
Click OK.

Fig. 8-5: Import New Upgrade Icon

Fig. 8-6: Select Upgrade Package Window

Upgrade package folder name.zip file selected
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6 A progress bar at the bottom of the RollCall Upgrade Packages window shows the 
upgrade package import progress. 
Import completion is reported in the Import Log pane. See Figure 8-7. 

The upgrade package has been added to RollCall Control Panel. Any new licenses imported 
with the package are shown in the ‘Currently Installed’ panel of the RollCall Update 
Packages window.

7 Close the dialog.

Stage 2: Install the Upgrade on the MV-8 Series Multiviewer 
This stage is applicable to an MV-8 Series Multiviewer in an MV-8 Series Multiviewer unit 
(or to an MV-820-IP’s video IP block). 

The instructions below describe the upgrade procedure with RollCall Control Panel. When 
set going below, the upgrade sequence of events on the unit is:

• File(s) downloaded to the multiviewer unit.
• Software upgraded and the unit restarts itself. 
• Programmable logic (FPGA firmware) upgraded (if required by the upgrade package 

used).
• Upgrade complete.

Instructions
To upgrade:

1 Right-click on the connected unit name in the RollCall Control Panel window. See 
Figure 8-8.

Fig. 8-7: Example RollCall Upgrade Packages Window - Import Log and Currently Installed 
Panes 
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2 Click Unit Upgrade in the drop-down menu. 
RollCall’s Unit Upgrade window is displayed.

Fig. 8-9: Unit Upgrade Widow

3 Select the Upgrade All Files radio button.

Fig. 8-8: Right-Click Menu

unit name

Unit Upgrade

Select ‘Upgrade All Files’.

Select the required software release to 
upgrade to.

Click ‘Upgrade’.
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4 In the Software Releases pull-down menu, select the Software Release required to 
upgrade to. 

5 Click Upgrade.
6 Click OK to upgrade.

A Unit Upgrade dialog is shown. 

Fig. 8-10: Unit Upgrade Dialog - Click NO

7 Click No in response to the question in the dialog (Figure 8-10). 

The upgrading begins...
8 The upgrade file is then automatically sent to the MV-8 Series Multiviewer. 

The MV-8 Series Multiviewer unit then starts to install the upgrade package onto itself. 

Note: Unit software and potentially the unit’s programmable logic circuitry is 
upgraded. This depends on the upgrade package. 

9 During the upgrade installation, the unit may restart one or more times and disconnect 
itself from RollCall Control Panel.

Note: (Figure 8-10) “Do you wish to save the current version before 
upgrading?”
The MV-8 Series Multiviewer does not support saving of current 
software version. 
Click No in response to the message box shown in Figure 8-10.
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Fig. 8-11: Upgrade Log Messages - Upgrade In Progress

Fig. 8-12: Upgrade Log Messages - Upgrade In Progress

During the unit upgrade process, 
the multiviewer output screens may sometimes be blank or may briefly show some 
unit information similar to the start up splash screens. Information messages shown on 
such screens includes:

• Upgrading to vM.M.M  (for example, “Upgrading to V3.1.6”)
Please wait...

• MV-8XX Multiviewer Booting... (for example, “Upgrading to V3.1.6”)
Please wait...

• Programming FPGAs. From FPGA vMMM to vNNN. (for example, “v280 to v290”)
“Please wait 16 minutes...”

• Snnnnnnnn MV-8xx Multiviewer booting...  (see Booting and Splash Screen, on 
page 9, Figure 2-1)

10 While the software upgrade is finalizing (see Figure 8-13), 
if the MV-8 Series Multiviewer’s programmable logic (FPGA) requires upgrading as part 
of this upgrade package, then this FPGA upgrade is done. 
It approximately takes a further 16 minutes to complete an FPGA upgrade.
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Fig. 8-13: Upgrade Log Messages - In Progress (“Finalizing upgrade” message: Wait)

11 An ‘Upgrade Complete’ message finally appears in the Update Log pane of RollCall 
Control Panel when the upgrade is done. See Figure 8-14 for typical Update Log 
messages. 

Click OK.

IMPORTANT 
Wait for the MV-8X0/8X1/8X5 Multiviewer unit to fully finish installing 
the upgrade file:
The unit can take approximately 15 to 20 minutes to install its upgrade 
package, depending of whether any of the unit’s programmable logic also 
needs upgrading as part of the upgrade package.

IMPORTANT
Wait. The unit is only fully ready for use:

• after software upgrade; and 
• after any FPGA upgrade; and
• after it has restarted (i.e. after a reboot, see Booting and Splash Screen, 

on page 9) and is showing its head display outputs as a video wall 
layout.

IMPORTANT 
For MV-8 Series Multiviewer software versions earlier than 2.8.17:

Wait for the unit being upgraded to be ready for use.
And ignore “Upgrade Complete” messages in RollCall Control Panel’s 
Unit Upgrade window (the message does not indicate that the unit’s 
upgrade is complete).

For MV-8 Series Multiviewer software versions 2.8.17 onwards:

The “Upgrade Complete” message in RollCall Control Panel’s Unit 
Upgrade window does indicate that the unit has been upgraded.
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When the MV-8 Series Multiviewer has rebooted:

12 The unit’s multiviewer head display outputs re-show a video wall layout. 
13 Grass Valley RollCall Control Panel may be reconnected to the unit.

The control screen for the MV-8 Series Multiviewer shows the upgraded software 
version.

14 Check that the MV-8X0/8X1/8X5 Multiviewer product’s front module has a flashing 
green CPU Heartbeat LED. (Refer to the corresponding MV-8X0/8X1/8X5 Multiviewer 
user manual for LED information.) This means the multiviewer unit restarted and is 
running. 
If this is not the case, contact Grass Valley Support.

Fig. 8-14: Typical Upgrade Log Messages - Upgrade Complete

IMPORTANT: 
For early Multiviewer software 
versions before 2.8.17, ignore 
any “Upgrade Complete” 
messages in RollCall Control 
Panel’s Unit Upgrade window 
and await unit full start-up.

Upgrade Complete

Click OK
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Download Log Files
MV-8 Series Multiviewer unit log files can be downloaded using GV Orbit Client:

1 Open the GV Orbit multiviewer project on the multiviewer with GV Orbit Client. 
(See Get Multiviewer Project from a Multiviewer Unit, on page 133, or 
Pull a Project from a Multiviewer Unit, on page 159.)

2 Select ‘Multiviewer > Download Logs’ in the main menu.

The Download Logs dialog is shown. 

Fig. 8-15: Download Logs Dialog

3 Select a Destination Directory.
4 Click Download.

The log file is downloaded.
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Video Inputs 

Video Inputs

Inputs 48-off ‘up-to-12G’ SDI, dependent on product and license 
applied. Up to 32 embedded audio channels per input.

Note: ASI inputs are not supported by MV-8 Series 
Multiviewers. ‘Loss of signal’ is reported for ASI inputs.

High Dynamic Range Inputs

HDR Optional HDR to SDR conversion. 

Opto-electrical Transfer Functions (OETFs) supported:
• PQ to SDR
• HLG to SDR
• Slog3 to SDR
• None (SDR-to-SDR)

Color Space Conversion to color spaces for inputs. 

Conversion:
• From BT.2020 color space to BT.709.
• None.

Media Biometrics Media biometric generator per input, analyzing input video 
and audio.
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Outputs

Head Display Outputs

Head Display Outputs 4 to 12 enabled video outputs.
• Outputs 1 to 4 on enabled as standard on MV-8 Series 

Multiviewer.
• Outputs 5 to 12 enabled with MV-8 Series Multiviewer 

output licenses.

Embedded Audio 16 channels of embedded audio per output. Audio channel 
pairs selectable from multiviewer input embedded audio.

Reference Head Display Outputs locked to:
• External Reference; or
• Internal Reference (i.e. free running).

Video Standard Video Standard on head display outputs:
• 3G 1080p, or HD 720p 
• 50, 59.94 & 60 frames/s.

Delay Latency: 
• Interlaced inputs: 1 input field + 1 to 3 output frames.
• Progressive inputs: 1 input frame + 1 to 3 output frames.
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H.264 Streaming Out of Video Input-Copies

Output Streams Up to 48-off H.264 streams, scaled copies of the multiviewer 
inputs. 

(On MV-821 multiviewers, this is a ‘H.264 stream’ licensed 
feature, also requiring factory-fitted hardware codec 
modules.)

Each multiviewer input is H.264 encoded to create streamed 
copies of the 48 inputs. 

Note: The H.264 streams do not function for the following 
slower-frame-rate HD standards:

• 1080p30 (and slower frame rates); and
• 720p30 (and slower frame rates).

Output Stream Encode 
Latency

The latency of the H.264 encoding is approximately
two video frames.

Note: Overall ‘end-to-end’ latency depends on:
• encoding latency; 
• any network latency; and on
• the decode latency when viewing the images.

In practice, it is the decode latency which is most significant 
and which effectively determines end-to-end latency. See in 
Chapter 4, Latencies, on page 91.

Ethernet Port Streamed out over multiviewer’s control and monitoring 
Ethernet port. Refer to respective MV-8X0/8X1 Multiviewer 
product user manual for Ethernet interface details.

(These H.264 streams can be viewed on desktop PCs using 
GV Orbit Client, or via the Orbit client with the Orbit MV-800-
DT license option if using the Orbit client). 

User applications include: confidence monitoring, 
compliance monitoring.)
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Multiviewer Monitoring and Alarms 

Monitoring and Alarms

Video:

Input: Monitoring of multiviewer video input:
• Media Biometrics.
• XDS.

Support for HDR inputs.

On-Screen 
Monitoring:

Fully flexible layouts:
• Any object can be any size, in any position.
• Adjustable layering and transparency of objects 

over video or other objects or background.
• Display up to 48 video tiles on a single screen. 
• Any router input can be assigned to any screen.
• WSS/AFD flags. 

Alarms:
• Video Input signal loss
• Video black
• Picture freeze or still
• Video Input format change.

Audio:

On-Screen 
Monitoring: • Metering of AES embedded audio:

• VU, extended VU, DIN, BBC, and Nordic scales
• Up to 32 audio channels per video signal
• Bars outside or overlaid on picture
• Audio meter scales on/off
• Programmable color & alarm thresholds

Alarms:
• Loss of:

• AC3 encoded audio data, 
• Dolby E encoded audio data.

• DialNorm under preset threshold. 
• Dolby E configuration change.
• Audio Level:

• Loss of audio.
• Audio level low/high.
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Video Wall Screen Display

Metadata and Control Monitoring:

On-Screen 
Monitoring: • Closed Caption & Subtitle detection

• V chip detection
• Display UMD router source names 

via General Remote protocol SW-P-08 over IP

Alarms: Loss of:
• Teletext. 
• Closed Caption (CC). 
• TS ID. 
• V-chip. 
• VITC. 
• Extended Data Services (XDS).

Alarm Control: Controls and features for:
• Configurable alarms trigger delays
• Alarm acknowledge/clear/previous fault indication 

(border color or tally alarm box)
• Alarm acknowledge from hardware or soft panels via 

Rollcall interface
• Layout recalls from hardware or soft panels, on-screen 

message boxes via Rollcall
• Alarm auto-clear after configurable period of time.

Monitoring and Alarms

Screen Display

Screen Design Facilities:
• Drag and drop objects on screen
• Configurable grid
• Snap to grid
• Object grouping and re-sizing
• Fixed/adjustable video tile aspect ratios
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Closed Captions Support for displaying closed caption information:.

OP42/OP47 Presentation Levels 1 and 1.5 are supported, 
which includes character sets for the following languages: 
English, German, Swedish/Finnish/Hungarian, Italian, 
French, Portuguese/Spanish, Czech/Slovak.

In a GV Orbit multiviewer video wall design, use a GV Orbit 
‘Closed Caption’ Behaviour to access closed caption 
information from MV-8 multiviewer video inputs. ‘Closed 
captions’ are supported for EIA-608 “line 21” and for EIA-708 
in compatibility-byte mode. Page numbers to use:

• CC1 - page 101
• CC2 - page 102
• CC3 - page 103
• CC4 - page 104
• WST - page 888 
• OP42 - page 801 (typically)
• OP47 - page 801 (typically)

Note: For SD video input sources, the vertical blanking 
interval (VBI) is used: 

For 625/25: 
• VITC is detected on line 19;
• OP42/WST on line 21; and
• WSS on line 23.

For 525/29: 
• VITC is detected on line 14; and
• Rec. 608 on line 21.

For HD/3G video input sources, the ancillary data (ANC) 
is used and there is no line number restriction.

Time code Time code:
• Display time code extracted from video and from 

multiviewer time code input

Time Time:
• Multiple clock display – lock to NTP, VITC or LTC, with 

time zone offsets
• Generate real-time clocks and timers with count up/

down capability

Screen Display
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Miscellaneous Control direct from mouse on screen.

TSL tally display.

Graphics / Images:
• Add graphics files to display labels and channel logos, 

etc
• Programmable background color or image

Screen Display

Tool Version

RollCall Control Panel 4.20.5 or later

Orbit Client 3.1.15 or later

GV Orbit 1.0.0 or later

GV Orbit Client 4.0.0 or later

MV-8 Series Multiviewer 3.2.22 or later

Note: For future releases:

Please refer to software release notes for compatibility 
information.
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XDS Data Types Supported
XDA Data Types ................................................................................................................ page 183
Program Identification Number (Scheduled Start Time) ........................................ page 183
Length / Time-in-Show .................................................................................................... page 184
Program Name (Title) (V Chip Label) ........................................................................... page 184
Program Type .................................................................................................................... page 184
Content Advisory (V Chip Rating) ................................................................................. page 184
Program Description ....................................................................................................... page 185
Network Name (Affiliation) ............................................................................................ page 185
Call Letters (Station ID) and Native Channel ............................................................. page 185
Time of Day ........................................................................................................................ page 185
Local Time Zone ................................................................................................................ page 185

The XDS data types supported by the MV-8 Series Multiviewer are presented in this 
appendix.

XDA Data Types

 Table B-1:   XDS Data Types Supported  

XDS Type
XDS Class Data Description

RollCall 
Command 

Number

(Hexa
decimal)

Program Identification Number (Scheduled Start Time)
Current 01 MM/DD hh:mm

Where:

MM = Month (1 - 12)

DD = Date (1 - 31)

hh = Hours (0 - 23)

mm = Minutes (0 - 59)

1800 - 1847
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Length / Time-in-Show
Length / Time-in-Show
Current 02 This carries two items of relevant data:

Program length: hh:mm

Where:

hh = Hours (0 - 63)

mm = Minutes (0 - 59)

1850 - 1897

Elapsed time: hh:mm:ss

Where:

hh = Hours (0 - 63)

mm = Minutes (0 - 59)

ss = Seconds (0 - 59)

1900 - 1947

Program Name (Title) (V Chip Label)
Current 03 A character string, up to 32 characters in 

length.
1600 - 1647

Program Type
Current 04 A list of up to 32 character strings.

Each string represents a descriptive name 
for the program content. 
For example, 
 “Education”, “Comedy”, ”Travel” etc.

For a list of names see the CEA-608-B 
specification.

2000 - 2047

Content Advisory (V Chip Rating)
Current 05 A short indication of the program rating. The 

string produced for each category depends 
on the region/rating system used. 

For full information, see the CEA-608-B 
specification.

1650 - 1697

 Table B-1:   XDS Data Types Supported  (continued)

XDS Type
XDS Class Data Description

RollCall 
Command 

Number

(Hexa
decimal)
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Current 10 - 17 A list of 8 strings separated by new lines. 1750 - 1797

Network Name (Affiliation)
Channel 
Information

01 A string of up to 32 characters. 1950 - 1997

Call Letters (Station ID) and Native Channel
Channel 
Information

02 This carries two items of relevant data:

Station ID.

Consists of a 4 character string.

2100 - 2147

Native channel.

Consists of a 2 character string.

2150 - 2197

Time of Day
Miscellaneo
us

01 WWW DD/MM/YYYY hh:mm

Where:

WWW = Day of the week 
    (Sunday to Saturday)

DD = Date (1 - 31)

MM = Month (1 - 12)

YYYY = Year (1990 - 2053)

hh = Hours (0 - 23)

mm = Minutes (0 - 59)

2050 - 2097

Local Time Zone
Miscellaneo
us

04 Two-character string: hh

Where:

hh = Hours (0 - 23)

2200 - 2247

 Table B-1:   XDS Data Types Supported  (continued)

XDS Type
XDS Class Data Description

RollCall 
Command 

Number

(Hexa
decimal)
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SNMP Support
SNMP Support
Introduction ....................................................................................................................... page 187
MIB Files .............................................................................................................................. page 188
MV-8 Series Multiviewer MIB .......................................................................................... page 188

mvStatus .................................................................................................................. page 189
mvAlarms ................................................................................................................ page 190
mvControl ................................................................................................................ page 191
mvEvents ................................................................................................................. page 192

Introduction
The MV-8 Series Multiviewer supports Simple Network Management Protocol (SNMP). The 
MV-8 Series Multiviewer Management Information.

The MV-8 Series Multiviewer System-Setup control screen has some SNMP settings. (See 
System-Setup Control Screen, on page 16, SNMP Managers box, on page 24, and SNMP 
Community Strings box, on page 24.)

Up to 8 SNMP managers can be configured to receive trap messages from the MV-8 Series 
Multiviewer. Once configured, a trap message will be sent to each manager whenever there 
is a change of alarm state.
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MIB Files
Management Information Base (MIB) files provide a graphical representation of the SNMP 
device to the user via a MIB browser tool. The following MIB files are required by an SNMP 
browser:

• PROBEL-COMMON.mib
• Multiviewer.mib

MV-8 Series Multiviewer MIB
The MV-8 Series Multiviewer MIB is ‘Multiviewer.mib’ , which has four main sections, see 
Figure C-1.

Fig. C-1: MV-8 Series Multiviewer MIB Tree

Note: Contact Grass Valley Customer Support for the MIB files. 
https://www.grassvalley.com/contact/support/

The multiviewer MIB tree comprises:

• mvStatus, on page 189
• mvAlarms, on page 190
• mvControl, on page 191
• mvEvents, on page 192
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mvStatus
The mvStatus section displays the overall status of the MV-8 Series Multiviewer, providing 
the similar information to that accessible in GV Orbit by right-clicking on the multiviewer 
name in the Network View and selecting ‘Details’ . See Figure C-2.

Fig. C-2: mvStatus MIB Tree

a) mvStatus MIB section b) In GV Orbit, right-click on multiviewer in Network View, select ‘Details’ .
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mvAlarms
The mvAlarms section comprises two sub-sections: unitAlarms and inputAlarms. It displays 
the alarm states of the MV-8 Series Multiviewer. See Figure C-3.

Fig. C-3: mvAlarms MIB Tree

unitAlarms:

• Temperature alarms (tempAlarmTable) - Providing names, status 
and temperature for each of the temperatures monitored.

• PSU alarms (psuAlarmTable) - Providing names and status for each 
of the PSUs monitored.

• Fan alarms (fanAlarmTable) - Providing names and status for each of 
the fans monitored.

• Reference and genlock state

inputAlarms:

This consists of a table of alarms for each of the 48multiviewer inputs. 
These can also be set up/viewed in GV Orbit or via the RollCall protocol.
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The mvControl section contains a ‘wallLayoutTable’, which allows control and interrogation 
of the video wall layout currently selected for each video wall. It allows the currently-
selected layout to be changed on each of the walls. See Figure C-4.

Fig. C-4: mvControl MIB Tree
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mvEvents
The mvEvents section lists the available SNMP traps that may be sent. See Figure C-5.
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Fig. C-5: mvEvents MIB Tree
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Multiviewer Terminology
This section describes some of the multiviewer terminology used in the manual and should 
be read alongside the example dual-screen video wall illustration shown in Figure D-1 on 
page 196.
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Fig. D-1: Example Video Wall of Two Monitor Display Screens

Video Wall

MV-8X0/8X1 Multiviewer Rear Panel 
(MV-821-HDBNC shown)

MV-8X0/8X1 Multiviewer Head Display Output 2MV-8X0/8X1 Multiviewer Head Display Output 1

Clock 
Widget

UMD 
Widget

Screen Screen

Video 
Widget

Audio Bars 
Widget

Video Tiles Clock Tile with 
Digital Clock 

widget

Tile Grid for Output 1 Tile Grid for Output 2
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 Table D-1:   Definition of Terms  

Term Definition

Wall, Video Wall One or more monitor display screens configured to form one large 
screen.

Screen Display area of one individual monitor/display device.

Theme The style and appearance of the video wall and its screen elements.

A Theme is a set of widget styles which can be applied to a project. 
Each widget may have one or more specific styles. 

Using themes, a video wall may be tailored to conform to a house 
style.

Style Each Widget can have several appearances, styles. Styles are 
changes to a widget’s appearance and do not affect its function. 
Styles can be grouped under themes.

Tile A rectangular area on a video wall screen, usually displaying video 
inputs and other supporting information. 

For example, a tile may display a video picture with audio level and 
other related status information. 

Other information may be displayed in tiles, for example, time, 
images, labels and/or text.

Tile Grid A multiviewer video wall screen is divided up into rectangular areas; 
various sizes and arrangements are possible. 
A tile grid can be used in the Grass Valley Orbit tool for quick-
positioning of tile arrangements on a wall.

Fine Grid A fine grid on a Grass Valley Orbit screen is used for the fine-
positioning of graphical elements. For example, for positioning Tiles 
on a wall or Widgets on a tile.

Widget On-screen graphical elements used to display information on tiles. 
There are one or more widgets on a tile. Displayed information 
includes: Audio sound level, Time, Text labels.

Widget types include: Audio bars, Clocks, Images, Labels, Lines, Tally 
LEDs, Timers, UMD’s, Video and Web sources.

Head Display 
Output

A 1080P or 720P output from the MV-8 Series Multiviewer. There are 
up to 12 head display outputs.

On the MV-8X0/8X1 Multiviewer product, this can be SDI (Coax or 
Fiber) or HDMI, or video-over-IP depending on the product version. 

Each head display output is then typically connected to a monitor 
display that forms all or part of a multiviewer video wall. 

Video Input One of 48 video inputs to the MV-8 Series Multiviewer in the MV-
8X0/8X1 Multiviewer product.
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Introduction
Introduction
This appendix describes the RollCall command set supported by the MV-8 Series core 
multiviewer, listing the supported direct RollCall command numbers.

This information is an extract taken from the following Grass Valley technical document and 
is applicable to all MV-8 Series multiviewers:

• MV-800 RollCall Interface; document version: 0.10; document number: MV800-RC-1

Contact Grass Valley customer support for more information.

Lastly, there is a GV Orbit Client Example Timecode Display provided which uses a RollCall 
command to present information on a video wall tile.

Reference Alarm Acknowledgment

Reference Input Lost
Reference Input Lost alarms can be acknowledged using the direct command 32000.

Genlock Source
Genlock Source alarms can be acknowledged using the direct command 32001.

Name Command Number Value

Reference Input Lost 32000 0 : No Alarm

1 : Acknowledged

2 : Unacknowledged

Name Command Number Value

Genlock Source0 32001 0 : No Alarm

1 : Acknowledged

2 : Unacknowledged
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The layout on individual multiviewer video wall monitors can be selected through RollCall 
commands. One to twelve video walls are supported for an MV-8 Series multiviewer, with 
up to 64 layouts per video wall monitor. 

Layout Selection

Note: The names associated with a video wall and the layouts that are 
used with the Layout Selection RollCall command are fixed and 
cannot be set by the user.
The user can see the video wall name in the Properties section of 
GV Orbit Client in a multiviewer project when a .wall file is 
opened. The name will be Wall1, Wall2, Wall3 etc. ... 
The name for a layout is “LayoutN” where N is an appended 
number in the range 1 to 64, e.g. Layout1, Layout2, etc. 

Name Direct Command Number Value

Wall1 1000

 Layout1

  Layout2

 ...

  Layout64

Wall2 1010

Wall3 1020

Wall4 1030

Wall5 1040

Wall6 1050

Wall7 1060

Wall8 1070

Wall9 1080

Wall10 1090

Wall11 1100

Wall12 1110
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Timer Control
Up to sixteen timers can be controlled through RollCall. A timer can be started, stopped, set 
and reset.

Timer Start/Stop
Timers can be started and stopped using the direct commands 15000 to 15015.

Timer Reset
Resetting an expired or currently-counting timer will return the timer to the stopped state 
with the time set to the last target time.

Timers can be reset using the direct commands 15100 to 15115.

Timer Set
A timer is set by sending a string with the desired target time. If a timer is currently running 
it will be set to the stopped state with the time set to the new target time.

Timers can be set using the direct commands 15200 to 15215.

Name Command Number Value

Timer 1 15000

0 : Timer Stopped

1 : Timer Running

Timer 2 15001

... ...

Timer 16 15015

Name Command Number Value

Timer 1 15100
0 : Timer Out of Reset State

1 : Timer In Reset State

Automatically clears value 
from 1 to 0

Timer 2 15101

Timer 3 15102

... ...

Timer 16 15115

Name Command Number Value

Timer 1 15200

HH:MM:SS
Timer 2 15201

... ...

Timer 16 15215
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A timer is configured as an incrementing or decrementing timer using a direct command. If 
a timer is currently running it will be set to the stopped state.

Timers can be set using the direct commands 15300 to 15315.

GPIO
Four GPIO values can be read through RollCall. The GPIO can be set to be inputs or outputs 
and can be individually enabled and the active level configured through the RollCall 
Template for the product.

GPIO Value
The current state of a GPIO can be read through a direct command.

GPIO value can be read using the direct commands 1401 to 1404.

Name Command Number Value

Timer 1 15300

0 : Decrementing

1 : Incrementing

Timer 2 15301

... ...

Timer 16 15315

Name Command Number Value

GPIO 1 1401

0 : Inactive

1: Active

GPIO 2 1402

GPIO 3 1403

GPIO 4 1404
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Logging
Log Field values are available on RollCall commands. 

The table below describes the Log fields and the range of commands associated with them. 
In the table:

• The first command number column is for input 1 and the second is for input 48. 
Other inputs fall in the range between these two numbers. 

• Audio Log Fields increment X for input, then Y for available channel.

Log Field
Command Number

Input 1 ... Input 48 

INPUT_X_CC1 41000 ... 41047
INPUT_X_CC2 41048 ... 41095
INPUT_X_CC3 41096 ... 41143
INPUT_X_CC4 41144 ... 41191
INPUT_X_T1 41192 ... 41239
INPUT_X_T2 41240 ... 41287
INPUT_X_T3 41288 ... 41335
INPUT_X_T4 41336 ... 41383
INPUT_X_XDS 41384 ... 41431
INPUT_X_VCHIP 41432 ... 41479
INPUT_X_TSID 41480 ... 41527
INPUT_X_CC608 41528 ... 41575
INPUT_X_DTVCC608 41576 ... 41623
INPUT_X_DTVCC708 41624 ... 41671
INPUT_X_OP42 41672 ... 41719
INPUT_X_OP47 41720 ... 41767
INPUT_X_SMPTE2010 41768 ... 41815
INPUT_X_DVITC 41816 ... 41863
INPUT_X_BLACK 41912 ... 41959
INPUT_X_FREEZE 41960 ... 42007
INPUT_X_STATE 42008 ... 42055
INPUT_X_FORMAT 42056 ... 42103
INPUT_X_STILLISH 42104 ... 42151
INPUT_X_EMBED_AUDIO_Y_LEVEL 42152 ... 43687
INPUT_X_EMBED_AUDIO_Y_DOLBYE_STATE 43688 ... 44455
INPUT_X_EMBED_AUDIO_Y_AC3_STATE 44456 ... 45991
INPUT_X_EMBED_AUDIO_Y_PCM_STATE 45992 ... 46759
INPUT_X_EMBED_AUDIO_Y_DIALNORM_UNDER 46760 ... 47527
INPUT_X_EMBED_AUDIO_Y_DOLBYE_CONFCHANGED 47528 ... 48295
REFERENCE_1_STATE 48296 N/A
GENLOCK_1_STATE 48297 N/A
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LTC
The system publishes the current LTC timecode for the multiviewer on Command ID 1200.

ATC
Each input publishes the ATC time code on a unique RollCall command if the Ancillary Data 
contains a timecode.

The time code for each input can be read through a direct command.

ATC values can be read using the direct commands 1201 to 1248.

VITC
Each input publishes the VITC time code on a unique RollCall command.

The time code for each input can be read through a direct command.

VITC values can be read using the direct commands 1300 to 1347.

Name Command Number Value

LTC timecode 1200 String

Name Command Number Value

ATC Input 1 1201

String
ATC Input 2 1202

... ...

ATC Input 48 1248

Name Command Number Value

VITC Input 1 1300

String
VITC Input 2 1301

... ...

VITC Input 48 1347
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Source ID from VANC
Each input publishes the Source ID extracted from input-video VANC data on a unique 
RollCall command.

The Source ID for each input can be read through a direct command.

Source ID values can be read using the direct commands 1500 to 1547.

V-Chip Program Label
Each input publishes the Program Name associated with V-Chip input on a unique RollCall 
command.

The V-Chip Program Name Label for each input can be read through a direct command.

V-Chip Program-Name values can be read using the direct commands 1600 to 1647.

V-Chip Rating
Each input publishes the V-Chip rating associated with the input on a unique RollCall 
command.

The V-Chip Rating for each input can be read through a direct command.

V-Chip Rating values can be read using the direct commands 1650 to 1697.

Name Command Number Value

Source ID Input 1 1500

String
Source ID Input 2 1501

... ...

Source ID Input 48 1547

Name Command Number Value

V-Chip Program Input 1 1600

String
V-Chip Program Input 2 1601

... ...

V-Chip Program Input 48 1647

Name Command Number Value

V-Chip Rating Input 1 1650

String
V-Chip Rating Input 2 1651

... ...

V-Chip Rating Input 48 1697
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SCTE-104 Detection
Each input publishes SCTE-104 Detection information on a unique RollCall command.

The SCTE-104 Detection for each input can be read through a direct command.

SCTE-104 Detection values can be read using the direct commands 1700 to 1747.

XDS

XDS Program Description
Each input publishes the Program description associated with the input on a unique 
RollCall command.

The Program Description for each input can be read through a direct command.

Program Description values can be read using the direct commands 1750 to 1797.

XDS Program ID
Each input publishes the Program ID associated with the input on a unique RollCall 
command.

The Program ID for each input can be read through a direct command.

Program ID values can be read using the direct commands 1800 to 1847.

Name Command Number Value

SCTE-104 Detected Input 1 1700

Boolean
SCTE-104 Detected Input 2 1701

... ...

SCTE-104 Detected Input 48 1747

Name Command Number Value

Program Description Input 1 1750

String
Program Description Input 2 1751

... ...

Program Description Input 48 1797

Name Command Number Value

Program ID Input 1 1800

String
Program ID Input 2 1801

... ...

Program ID Input 48 1847
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XDS Program Length
Each input publishes the Program Length associated with the input on a unique RollCall 
command.

The Program Length for each input can be read through a direct command.

Program Length values can be read using the direct commands 1850 to 1897.

XDS Program Elapsed Time
Each input publishes the Program Elapsed Time associated with the input on a unique 
RollCall command.

The Program Elapsed Time for each input can be read through a direct command.

Program Elapsed Time values can be read using the direct commands 1900 to 1947.

XDS Network Name
Each input publishes the Network Name associated with the input on a unique RollCall 
command.

The Network Name for each input can be read through a direct command.

Network Name values can be read using the direct commands 1950 to 1997.

Name Command Number Value

Program Length Input 1 1850

String
Program Length Input 2 1851

... ...

Program Length Input 48 1897

Name Command Number Value

Program Elapsed Time Input 1 1900

String
Program Elapsed Time Input 2 1901

... ...

Program Elapsed Time Input 48 1947

Name Command Number Value

Network Name Input 1 1950

String
Network Name Input 2 1951

... ...

Network Name Input 48 1997
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XDS Program Type
Each input publishes the Program Type associated with the input on a unique RollCall 
command.

The Program Type for each input can be read through a direct command.

Program Type values can be read using the direct commands 2000 to 2047.

XDS Time Of Day
Each input publishes the Time Of Day associated with the input on a unique RollCall 
command.

The Time Of Day for each input can be read through a direct command.

Time Of Day values can be read using the direct commands 2050 to 2097.

XDS Station ID
Each input publishes the Station ID associated with the input on a unique RollCall 
command.

The Station ID for each input can be read through a direct command.

Station ID values can be read using the direct commands 2100 to 2147.

Name Command Number Value

Program Type Input 1 2000

String
Program Type Input 2 2001

... ...

Program Type Input 48 2047

Name Command Number Value

Time Of Day Input 1 2050

String
Time Of Day Input 2 2051

... ...

Time Of Day Input 48 2097

Name Command Number Value

Station ID Input 1 2100

String
Station ID Input 2 2101

... ...

Station ID Input 48 2147
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XDS Channel Number
Each input publishes the Channel Number associated with the input on a unique RollCall 
command.

The Channel Number for each input can be read through a direct command.

Channel Number values can be read using the direct commands 2150 to 2197.

XDS Time Zone
Each input publishes the Time Zone associated with the input on a unique RollCall 
command.

The Time Zone for each input can be read through a direct command.

Time Zone values can be read using the direct commands 2200 to 2247.

XDS Channel Number
Each input publishes the Channel Number associated with the input on a unique RollCall 
command.

The Channel Number for each input can be read through a direct command.

Channel Number values can be read using the direct commands 2150 to 2197.

Name Command Number Value

Channel Number Input 1 2150

String
Channel Number Input 2 2151

... ...

Channel Number Input 48 2197

Name Command Number Value

Time Zone Input 1 2200

String
Time Zone Input 2 2201

... ...

Time Zone Input 48 2247

Name Command Number Value

Channel Number Input 1 2150

String
Channel Number Input 2 2151

... ...

Channel Number Input 48 2197
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XDS Time Zone
Each input publishes the Time Zone associated with the input on a unique RollCall 
command.

The Time Zone for each input can be read through a direct command.

Time Zone values can be read using the direct commands 2200 to 2247.

Name Command Number Value

Time Zone Input 1 2200

String
Time Zone Input 2 2201

... ...

Time Zone Input 48 2247
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Example Timecode Display
This example presents a timecode value on a video wall tile using GV Orbit Client and a 
multiviewer project. This example modifies a 2x2 video wall, replacing one tile with a 
custom ‘timecode’ tile.

The timecode value is obtained from a MV-8 multiviewer with a RollCall command, 
Command ID 1200, using GV Orbit Client’s Behaviours and Bindings that can be associated 
with on-screen graphical widgets.

Fig. E-1: Timecode Presented on a Video Wall Tile

Assumptions made by the example:
• There is an existing multiviewer video wall project and multiviewer available.
• The multiviewer video wall project is open in GV Orbit Client.

Procedure
The steps required to do this are:

1 Step 1: Create a Blank Custom Tile on Our Wall
2 Step 2: Add Timecode to a Custom Tile
3 Step 3: Exercise the Custom Timecode Tile
4 Step 4: Run on Multiviewer

Start at step 2 if you already have a candidate custom tile to add timecode to.

Step 1: Create a Blank Custom Tile on Our Wall
Firstly, we create a blank custom tile on the video wall to work with:

1 Open the multiviewer project in GV Orbit Client and view the video wall design in 
Design Mode (not Run Mode).
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Fig. E-2: 2x2 Video Wall in Design Mode

2 Select a video tile to modify and 
change its ‘Preferences > Type’ property to ‘Analogue Clock’ .

Fig. E-3: Tile ‘Preference > Type’ Change

This changes the tile from a video tile to a clock tile.
3 Double-click on the clock tile to create a custom tile from it.

Enter a new tile name in the Create Custom Tile dialog and click OK.
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Fig. E-4: Enter a Name for Custom Tile

The new custom tile is shown in the Tile Editor.
4 Select the Clock widget and delete it.

This clears the tile for our example.
5 Click Save File in the main tool bar.

We now have a correctly-sized, blank custom tile to use in our example.
6 Go to the Wall tab and see our new blank tile ready for adding timecode to.

Fig. E-5: Blank Custom Tile

Step 2: Add Timecode to a Custom Tile
With a custom tile in the Tile Editor and the GV Orbit Client in Design Mode:

1 Click on the ‘Text Label ‘widget icon ( , at the bottom of the GV Orbit Client 
window) and add a Label widget to the tile.

2 Select the Label widget and, for cosmetic purposes, change some properties:
• ‘Extended Style > Font > Color’ - set this to white (to be easier to see);
• ‘Extended Style > Fill > Fill Color’ - set this to a medium gray (forms a simple box 

around our text); and 
• ‘General > Caption’ - set this to “LTC value” (this initial text will be overwritten 

when timecode values are read from the multiviewer).
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Fig. E-6: Added Label

3 With the Label widget still selected, click on the Edit Behaviours icon ( ).
4 The graphical ‘Behaviours and Bindings’ editor opens. See Figure E-7.

Fig. E-7: Behaviours and Bindings Editor

5 Click on the ‘RollCall+ Command’ Behaviour to add it to the editor. See Figure E-8.

Click the Edit Behaviours icon

‘Behaviours and Bindings’ editor
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Fig. E-8: Add ‘RollCall+ Command’ Behaviour (with a ‘Direct’ Binding)

A ‘RollCall+ Command’ Behaviour is added to the graphical ‘Behaviours and Bindings’ 
editor stage area. Additionally, a ‘Direct’ Binding is also automatically added.

6 Double-click on the added Behaviour.

The Behaviour’s properties are shown.

‘RollCall+ Command’ Behaviour 
added with a ‘Direct’ Binding
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Fig. E-9: Modify Behaviour Properties

7 Modify the Behaviour’s properties, see Figure E-9.
8 Click Close.
9 Click Save File in the main tool bar.

The custom tile design has been saved. See Figure E-10.

Modify properties:
• Address - set this to the RollCall address of the multiviewer. 

(For example, “2000:66:00”)
• Command Number - set this to “1200” 

(i.e. the LTC direct command ID number).
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Fig. E-10: Completed Custom LTC Tile

Step 3: Exercise the Custom Timecode Tile
1 Click Save Project in the main tool bar.
2 To close the graphical ‘Behaviours and Bindings’ editor, click the Edit Behaviours icon.
3 Click on the Run Mode icon ( ) to run the tile/video wall in GV Orbit Client.

Live (LTC) timecode is displayed on the tile in GV Orbit Client. See Figure E-11.
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Fig. E-11: Custom LTC Tile Running, Showing Live Time Code

Step 4: Run on Multiviewer
To see this on the multiviewer video wall: 

1 Push the project to the multiviewer device by clicking the Push icon in the main tool 
bar.

Note: Optional widgets added here for annotation:

• static labels;
• a line; and 
• an analogue clock.

Live timecode shown.
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Grass Valley Technical Support
For details of our Regional Customer Support Offices please visit the Grass Valley web site 
and navigate to Support/Customer Support Contacts.

https://www.grassvalley.com/contact/support/

Customers with a support contract should call their personalized number, which can be 
found in their contract, and be ready to provide their contract number and details.

Corporate Head Office
Grass Valley

3499 Douglas-B.-Floreani

St-Laurent, Quebec  H4S 2C6

Canada

Telephone:+1 514 333 1772

Fax:+1 514 333 9828

www.grassvalley.com
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